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About this book

This book provides information about setting up, installing, configuring, and working
with the IBM® FAStT Remote Mirror Option. This option is used with IBM Fibre
Array Storage Technology (FAStT) Storage Manager Version 8.2. This Installation
and User’s Guide is for system administrators who are responsible for operating
and maintaining storage systems, with an emphasis on disaster prevention and
recovery. Refer to the online help systems for detailed storage management
procedures for topics not referred to in this book. Use this guide to:

» Determine the hardware and software that are required to install the IBM FAStT
Remote Mirror Option

* Integrate the necessary hardware components into your network

* Install, enable, and activate the IBM FAStT Remote Mirror Option

 |dentify other storage-management premium features that are unique to your
specific installation

» Troubleshoot hardware and software problems

Before you begin the installation of this product, make sure that you have
purchased the premium feature key and consult the following documentation:

+ README.TXT file - Read this text file first. The README file is located in the
root directory of the installation CD. Refer to the IBM Web site at
http://www.ibm.com/pc/support for the latest installation and user information.

* IBM FASLT Storage Manager Version 8.2 Installation and Support Guide - Use
this document to become familiar with terminology and features of the IBM FAStT
Storage Manager Version 8.2 software. You can download this book from the
http://www.ibm.com/pc/support Web site.

How this book is organized

[Chapter 1, “Introduction” on page 1| provides an introduction to the IBM FAStT
Remote Mirror Option and describes the hardware and software requirements for
using the Remote Mirror Option, configuration types, describes how the Remote
Mirror Option interfaces with other premium features, such as Storage Partitioning
and FlashCopy™ logical drives, and provides a hardware and software checklist to
ensure that all the requirements are met before installing and configuring your
systems.

[Chapter 2, “Hardware and software installation” on page 21| provides information on
the site preparation and instructions for installing key hardware and software
components.

[Chapter 3, “Using the Remote Mirror Option” on page 43| provides step-by-step
instructions on enabling and activating the IBM FAStT Remote Mirror Option,
creating a mirror relationship, and maintaining a mirror relationship.

[Chapter 4, “Disaster recovery” on page 53| provides a number of scenarios about
how the IBM FAStT Remote Mirror Option can help prevent data loss, and assist
with the recovery of critical data if a disaster or unrecoverable error occurs.

|Chapter 5, “Troubleshooting” on page 61|provides information for troubleshooting
hardware and software components, and describes events that might be logged
when using the Remote Mirror Option.

© Copyright IBM Corp. 2002 xi



l[Appendix A, “Getting information, help, and service” on page 73| provides
information about how to obtain help, service, or technical assistance.

lAppendix B, “Notices” on page 77| provides product notices and trademark
information.
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Notices used in this book

This book contains the following notices designed to highlight key information:

Notes: These notices provide important tips, guidance, or advice.

Important: These notices provide information that might help you avoid
inconvenient or problem situations.

Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

Related publications

The following publications are available in Adobe Acrobat Portable Document
Format (PDF) on the IBM FAStT Storage Manager CD and at the
http://www.ibm.com/pc/support/ Web site.

IBM FAStT Remote Mirror Option Installation and User’s Guide (this book)

IBM FAStT Storage Manager Version 8.2 Installation and Support Guide for
Microsoft Windows NT and Windows 2000

IBM FAStT Storage Manager Version 8.2 Installation and Support Guide for
Novell NetWare

IBM FAStT Storage Manager Version 8.2 Installation and Support Guide for
Linux®

IBM TotalStorage™ FAStT700 Fibre Channel Storage Server Installation Guide
IBM TotalStorage FAStT700 Fibre Channel Storage Server User’s Guide

IBM FAStT700 Fibre Channel Cabling Instructions

IBM Netfinity FAStT500 Raid Controller Enclosure Unit Installation Guide

IBM Netfinity FAStT500 Raid Controller Enclosure Unit User’s Guide

IBM FAStT FC-2 Host Bus Adapter Installation and User’s Guide

IBM FAStT MSJ User’s Guide

In addition, the following IBM Redbooks™ might be of interest:

Fibre Array Storage Technology: A FAStT Introduction

Implementing Netfinity Disk Subsystems: ServeRAID SCSI, Fibre Channel, and
SSA

Tuning Netfinity Servers for Performance: Getting the most out of Windows 2000
and Windows NT 4.0

Netfinity Director: Integration and Tools
Netfinity Clustering Planning Guide

You can download these books from the http://www.ibm.com/redbooks Web site.

About this book  Xili



XiV  IBM FAStT Remote Mirror Option: Installation and User’s Guide



Chapter 1. Introduction

This chapter introduces the basic concepts of the Remote Mirror Option, describing
what a remote mirror is, how information is replicated between storage subsystems,
the software and hardware required, and the preferred system configurations.

Introduction to the Remote Mirror Option

The Remote Mirror Option is a premium feature that comes with the IBM FAStT
Storage Manager 8.2 software and is enabled by purchasing a premium feature
key. The Remote Mirror Option is used for online, real-time replication of data
between storage subsystems over a remote distance. In the event of a disaster or
unrecoverable error at one storage subsystem, the Remote Mirror Option enables
you to promote a second storage subsystem to take over responsibility for normal
input/output (I/O) operations.

The maximum number of storage subsystems that can participate in a remote
mirror configuration is two. The two storage subsystems are called primary and
secondary storage subsystems or as local and remote storage subsystems. These
names are used interchangeably to describe remote mirror setups or concepts. The
names do not refer to the location of storage subsystems or the role storage
subsystems have in a remote mirror relationship.

Primary and secondary logical drives on a remote mirror setup

This section introduces you to primary and secondary logical drives, and describes
how they interact to replicate data between storage subsystems using the Remote
Mirror Option. When you create a remote mirror, a mirrored logical drive pair is
defined and consists of a primary logical drive at the primary storage subsystem,
and a secondary logical drive at a secondary storage subsystem. A standard logical
drive might only be defined in one mirrored logical drive pair, the maximum number
of supported mirrored logical drive pairs is determined by the storage subsystem
model.

The primary and secondary role in a remote mirror setup is implemented at the
logical drive level instead of at the storage subsystem level. A storage subsystem
can have all logical drives participating in a remote mirror relationship be in either a
primary or secondary role only. The storage subsystem can also have a
combination of logical drives in a primary role and logical drives in a secondary role.
Whether the logical drive is in a primary or secondary role, it counts towards of the
maximum number of mirror logical drive pairs that can be defined in a storage
subsystem.

There are no requirements for having certain number of logical drives be of certain
role in a remote mirror relationship for a given storage subsystem. For example, a
storage subsystem with a maximum of 16 remote mirror relationship pairs might
have logical drives in any one of the following remote mirror relationship
combinations:

© Copyright IBM Corp. 2002 1



2

Remote mirror drives in a Remote mirror drives in a Description
primary role secondary role

16 0 This storage subsystem
(local) has data in 16 logical
drives mirrored in 16 logical
drives in a separate (remote)
storage subsystem.

8 8 This local storage subsystem
has data in 8 logical drives
mirrored in 8 logical drives in
a remote storage subsystem.
It also have 8 logical drives
that are used to store the
mirrored data from 8 logical
drives in a remote storage
subsystem.

4 12 This local storage subsystem
has data in 4 logical drives
mirrored in 4 logical drives in
a remote storage subsystem.
It also have 12 logical drives
that are used to store the
mirrored data from 12 logical
drives in a remote storage
subsystem.

0 16 This local storage subsystem
has 16 logical drives that are
used to store the mirrored

data from 16 logical drives in
a remote storage subsystem.

There is a limit to how many logical drives that you can create in a single storage
subsystem. When Remote Mirror Option is enabled, the total number of logical
drives that are supported for each storage subsystem is reduced from the number
of logical drives you would have without the Remote Mirror Option enabled. The
reduced maximum number of logical drives that a FAStT storage subsystem can
support with firmware version 05.20.xx.xx depends on the model of the FAStT
storage subsystem. Refer to [Table 1] for more information.

Table 1. Logical drives using the Remote Mirror Option

Model Type | Maximum logical Maximum logical drives | Maximum flashCopy
drives per storage unit logical drives
partition
3542 N/A7 N/A7 N/A 7
3552 128°%6 32° 642
1742 256" 46 32° 1282

Note: The access logical drive is also referred to as the Universal Xport Device.

“When using firmware version 5.xx.xx, the firmware reserves one logical drive for
use by the system.

2 Maximum of four FlashCopy logical drives for each standard logical drive

IBM FAStT Remote Mirror Option: Installation and User’s Guide



8- Maximum of eight remote mirror pairs
4 Maximum of 16 remote mirror pairs

>The host-agent management method uses a special logical drive, called an access
logical drive, to communicate with the controllers on the storage subsystem. The
access logical drive uses one of the available LUNs. Therefore, managing storage
subsystems with the host-agent software limits you to one fewer LUN than the
maximum number supported by the operating system and the host adapter.

5-For firmware version 05.20.xx.xx, the maximum number of logical drives includes
the flashCopy repository logical drives and the remote mirror repository logical
drives, in addition to the standard data logical drives. If the Remote Mirror Option is
enabled, two logical drives are reserved for use by the system.

7 The IBM FAStT200 (machine type 3542) storage subsystem does not support the
Remote Mirror Option.

The primary logical drive is the drive that accepts host computer I/O and stores
program data. When the mirror relationship is first created, data from the primary
logical drive is copied (becomes a mirror image) in its entirety to the secondary
logical drive. This process is known as a full synchronization and is directed by the
controller owner of the primary logical drive. During a full synchronization, the
primary logical drive remains fully accessible for all normal I/O operations.

When a write request is made to the primary logical drive, the controller owner of
the primary logical drive also initiates remote write request to the secondary drive.
The write request does not complete until both write requests are performed. This
additional write request keeps the data on the two logical drives in the remote
mirror relationship synchronized. Whenever the data on the primary drive and the
secondary drive becomes unsynchronized, the controller owner of the primary drive
initiates a full synchronization.

The secondary logical drive is used to store data copied from its associated primary
logical drive. The controller owner of the secondary logical drive receives remote
writes from the controller owner of the primary logical drive and will not accept host
computer read or write requests.

The secondary logical drive is unavailable to host computer programs while
mirroring is performed. In the event of a disaster or unrecoverable error of the
primary storage subsystem, a role reversal is performed to promote the secondary
logical drive to the primary logical drive. Host computers will then be able to access
the newly promoted logical drive and normal operations can continue.

|Figure 1 on page 4| shows the primary and secondary logical drives displayed in the
Subsystem Management window for the primary storage subsystem and the
secondary storage subsystem.

Chapter 1. Introduction 3



Primary storage subsystem Secondary storage subsystem

[ Logical/Physical View I [ 1] Logical/Physical View |

Logical Logical

£E Storage Subsystem Primary Site 5 Storage Subsystem Secondary Site
ﬁ Unconfigured Capacity (8.44 GB) @ Unconfigured Gapacity (8.44 GB)
B Logical Drive Group 1 (RAID 5) - I§g Logical Drive Group 1 (RAID 5)

--|[§@ CTL A Mirror Repository (0.004 GB) [E8 CTL A Mirror Repository (0.004 GB),
CTL B Mirror Repository (0.004 GB) {8 CTL B Mirror Repository (0.004 GB)
[§) Free Capacity (10.873 GB) - [§! Free Capacity (10.873 GB)

E j| Primary Logical Drive (5 GB) | E‘| Secondary Logical Drive |

i Secondary Logical Drive |

Both the primary and secondary logical drives Only the secondary logical drive is displayed
are displayed in the Subsystem Management in the Subsystem Management window for the
window for the storage subsystem. Secondary storage subsystem.

Figure 1. Primary and secondary logical drives displayed in the Subsystem Management
window

Mirror repository logical drives

4

A mirror repository logical drive is a special logical drive in the storage subsystem
created as a resource for the controller owner of the primary logical drive in a
remote logical drive mirror. The controller stores mirrored information on this logical
drive, including information about remote writes that are not yet written to the
secondary logical drive. The controller can use this information to recover from
controller resets and accidental powering-down of storage subsystems.

When you activate the Remote Mirror Option on the storage subsystem, two mirror
repository logical drives will be created by the system, one for each controller in the
storage subsystem. An individual mirror repository logical drive is not needed for
each mirror logical drive pair.

When you create the mirror repository logical drives, you specify the location of the
logical drives. You can either use existing free capacity (shown in

or you can create an array for the logical drives from unconfigured capacity
and then specify the redundant array of independent disks (RAID) level.

Because of the critical nature of the data that is stored, the RAID level of mirror
repository logical drives must be non-zero. The required size of each logical drive is
4 MB, for each mirror repository logical drive.

|Figure 2 on page 5| shows mirror repository logical drives displayed in the
Subsystem Management window for the primary storage subsystem.

IBM FAStT Remote Mirror Option: Installation and User’s Guide



o Logical/Physical View |
Logical

| =1 Storage Subsystem Primary Site

[:l Unconfigured Capacity (8.44 GB)
5 % Logical Drive Group 1 (RAID 5)
. CTL A Mirror Repository (0.004 GB)
CTL B Mirror Repository (0.004 GB)
Ejl Free Capacity (10.873 GB)
Primary Logical Drive (5 GB)
- Secondary Logical Drive

Mirror Repository logical drives

Figure 2. Mirror repository logical drives displayed in the Subsystem Management window

Mirror relationships
Before you define a mirror relationship, the Remote Mirror Option must be enabled
on both the primary and secondary storage subsystems. A secondary standard
logical drive candidate must be created on the secondary storage subsystem if one
does not already exist, it must be a standard logical drive, and is at least the same
size or larger than the primary logical drive.

When secondary logical drive candidates are available, you can define a mirror
relationship in the storage-management software by identifying the storage
subsystem containing the primary logical drive and the storage subsystem
containing the secondary logical drive.

When you set up the mirror relationship, a full synchronization occurs as data from
the primary logical drive is copied in its entirety to the secondary logical drive. For
more information on establishing mirror relationships, refer to [‘Creating mirror
[relationships” on page 46|

Data replication

This section describes how data is replicated between storage subsystems
participating in remote logical drive mirroring, and the actions taken by the controller
owner of the primary logical drive if a link interruption occurs between storage
subsystems. Data replication between the primary logical drive and the secondary
logical drive is managed by the controllers and is transparent to host computers and

programs.

When the controller owner of the primary logical drive receives a write request from
a host computer, the controller first logs information about the write to its mirror
repository logical drive, and then writes the data to the primary logical drive. The
controller then initiates a remote write operation to copy the affected data blocks to
the secondary logical drive at the secondary storage subsystem.

After the host computer write request is written to the primary logical drive and the
data is successfully copied to the secondary logical drive, the controller removes

Chapter 1. Introduction 5



the log record on the mirror repository logical drive and sends an 1/O completion
indication back to the host computer. See for the data replication process.

1. Host sends 3. Data is logged to 4. Data is written to the 5. Data is then copied to
write request. the mirror repository Primary logical drive. the mirrored secondary
logical drive. logical drive.

Host

Mirror
Repository
logical drive

Primary
logical drive| | b

Controller || Controller

I
A B !
I
Primary 1 Secondary
storage subsystem : storage subsystem
I
2. Write request received 6. I/0 completion indication sent.

by controller owner of
primary logical drive.

Figure 3. Data replication between primary and secondary storage subsystems

Because the controller does not send the I/O completion to the host computer until
the data is copied to both the primary and secondary logical drives, this mirroring
operation is called synchronous.

When a read request is received from a host computer, the controller owner of the
primary logical drive manages the request. No communication takes place between
the primary and secondary storage subsystems.

Link interruptions or secondary logical drive errors

In the course of processing write requests, a primary controller might be able to
write to the primary logical drive, while a link interruption prevents communication
with the remote secondary controller.

After a link interruption, the remote write cannot complete to the secondary logical
drive and the primary and secondary logical drives are no longer correctly mirrored.
The primary controller transitions the mirrored pair into an Unsynchronized status
and sends an I/O completion to the primary host computer, as shown in
The primary host computer can continue to write to the primary logical drive
but remote writes will not take place.

6 IBM FASIT Remote Mirror Option: Installation and User’s Guide



Primary Storage Subsystem Secondary Storage Subsystem

(0 Logical/Physical View | [ Logical/Physical View |

Logical Logical

| Storage Subsystem Primary Site £5 Storage Subsystem Secondary Site

Efj Unconfigured Capacity (8.44 GB) -[] Unconfigured Capacity (8.44 GB)

E[% Logical Drive Group 1 (HA|D 5) E‘% Logical Drive GI’OUp 1 (RA'D 5)
Mirror Repository 1 (0.004GB) Mirror Repository 1 (0.004GB)

Mirror Repository 2 (0.004GB) i [ Mirror Repository 2 (0.004GB)

& £ Primary Logical Drive (5 GB) B8 Secondary Logical Drive
@ Secondary Logical Drive

Figure 4. Mirrored logical drive pair showing Unsynchronized status

When connectivity is restored between the controller owner of the primary logical
drive and the controller owner of the secondary logical drive, a full synchronization
automatically takes place. The mirrored pair transitions from an Unsynchronized
status to a Synchronization-in-Progress status, as shown in [Figure 5|

Primary Storage Subsystem Secondary Storage Subsystem
[T LogicalPhysical View | {1 Logical/Physical View |
Logical

Lagical

FE Storage Subsystem Primary Site

[j Unconfigured Capacity (8.44 GB)
E[% Logical Drive Group 1 (RAID 5)
Mirror Repository 1(0.004 GB)
Mirror Repository 2 (0.004 GB)

£E Storage Subsystem Secondary Site
E Unconfigured Capacity (8.44 GB)
E% Logical Drive Group 1 (RAID 5)
:J53 Mirror Repository 1(0.004 GB)
Mirror Repository 2 (0.004 GB)

E@ Secondary Logical Drive

=43 Primary Logical Drive (5 GB)
{7 Secondary Logical Drive

Figure 5. Mirrored logical drive pair showing Synchronization-in-Progress status

The primary controller marks the mirrored pair as unsynchronized when a logical
drive error from the secondary storage subsystem prevents a remote write from
completing. For example, an offline or a failed secondary logical drive can cause
the remote logical drive mirror to become unsynchronized. When the logical drive
error is corrected (the secondary logical drive is placed online or recovered to an
Optimal status) then a full synchronization automatically begins and the mirrored
pair transitions to a Synchronization-in-Progress status.

For more information about remote-mirror option status, refer to|Chapter 3, “Usinq
the Remote Mirror Option” on page 43

Chapter 1. Introduction 7



Connectivity and 1/0

The Remote Mirror Option requires a dedicated host port for mirroring data between
storage subsystems. This section describes three configurations that you can use to
connect storage subsystems for remote logical drive mirroring, controller ownership
of logical drives within storage subsystems, the maximum storage subsystem
distance permitted, and some general performance considerations. If these
configurations do not meet your remote mirror configuration requirement, contact
your IBM technical-support representative.

Host mini hubs

Controller A host port A1
Controller B host port B1
Controller A host port A2
Controller B host port B2

4
S} SARSENSA RS
.| 28 0| 0@ 0@ 00
. =S =FE I i
0s 3 o Jo ol
mini-hub RS =25
u \ e o] 1
ports @«- ® i
|0 [E==)355
g

Figure 6. Controller A and Controller B host ports

The Remote Mirror Option is supported on FASIT storage subsystems that have at
least two Fibre Channel host ports per controller (machines type 3553 and 1742).
When Remote Mirror Option is activated, one Fibre Channel host-side I/O port on
each controller is dedicated only to mirroring operations. For example, in the
primary storage subsystem, controller host ports A2 and B2 are dedicated to
mirroring operations. In the secondary storage subsystem, controller host ports A2
and B2 are also dedicated to mirroring operations. Seefor the location of
the controller host port.

Each of the controller host ports are connected to a mini hub. Each mini hub has
two SFP or GBIC port slots. If the first mini-hub SFP or GBIC port slot is connected
to a Fibre Channel switch port as part of remote mirror setup, the second mini-hub
port must not be occupied.

Host-initiated 1/O operations are refused by the dedicated port. Requests received
on this dedicated port are accepted from only a controller participating in the remote
mirror relationship.

Controller ports dedicated to the remote logical drive mirror must be attached to a
Fibre Channel fabric environment with support for the Directory Service and Name
Service interfaces.

Fibre Channel fabric configurations

8

The level of redundancy available depends on which Fibre Channel fabric
configuration you use. The three Fibre Channel fabric configurations that are
supported in version 8.2 of the storage-management software are as follows:

* Highest Availability Campus configuration - A fully redundant configuration
that consists of a primary storage subsystem and a secondary storage

IBM FAStT Remote Mirror Option: Installation and User’s Guide



subsystem. This fully redundant configuration has a connection distance up to 10
Km (6.25 mi). For more information, refer to [‘Highest Availability Campus|
[configuration” on page 16}

« Campus configuration - A lower-cost configuration which consists of a primary
storage subsystem and a secondary storage subsystem. This low-cost
configuration has a connection distance up to 10 Km (6.25 mi). For more
information, refer to |“Campus configuration” on page 17I

+ Intra-site configuration - A low-cost configuration where the primary storage
subsystem and secondary storage subsystem are located within the same site.
For more information, refer to[“Intra-site configuration” on page 18|

For instructions on how to configure storage subsystems, refer to|Chapter 2,
FHardware and software installation” on page 21|

Logical drive ownership

The controller owner of the primary logical drive attempts to communicate with only
its mirrored controller in the secondary storage subsystem. As shown in
Controller A in the primary storage subsystem with attempts communication with
Controller A in the secondary storage subsystem.

The controller (A or B) that owns the primary logical drive determines the controller
owner of the secondary logical drive. Regardless of the secondary logical drive
controller ownership, If the primary logical drive is owned by Controller A on the
primary storage subsystem, the secondary logical drive is then owned by Controller
A on the secondary storage subsystem. If primary Controller A cannot communicate
with secondary Controller A, no controller ownership changes take place and the
remote mirror link is broken for that mirror logical drive pair. When primary controller
A can communicate with secondary controller A, the next 1/O request to the primary
logical drive will result in a secondary drive ownership change.

Secondary
logical drive
Finance

Primary
logical drive
Finance

Port | Port Port Port Port
B2 B1 A2 A1l Al

Controller B Controller A Controller B Controller A
Primary storage subsystem Secondary storage subsystem

Figure 7. Controller A shown as the controller owner

When an 1/O path error causes a logical drive ownership change on the primary
storage subsystem, or if the storage administrator changes the controller owner of
the primary logical drive, the next remote write that is processed automatically starts
an ownership change on the secondary storage subsystem.

Chapter 1. Introduction 9



As shown in [Figure g if a primary logical drive is owned by Controller A and the
controller owner is changed to Controller B, the next remote write changes the
controller owner of the secondary logical drive from Controller A to Controller B.

Primary Secondary
logical drive

Finance

logical drive
Finance

Port Port Port Port Port Port Port Port
B2 B1 A2 A1 B2 B1 A2 Al

Controller B Controller A Controller B Controller A
Primary storage subsystem Secondary storage subsystem

Figure 8. Controller B shown as controller owner

Because controller ownership changes on the secondary storage subsystem are
controlled by the primary controller, they do not require any special intervention and
the system administrator cannot be manually change them.

Primary and secondary storage subsystem connection distance

The maximum connection distance permitted between storage subsystems
participating in a mirror relationship is governed by the distance limits of the Fibre
Channel interswitch links (ISL). Using standard single-mode fiber technology, a
maximum link distance of 10 Km (6.25 mi) between storage subsystems can be
achieved. In addition, the ISL link must be a standard Fibre Channel connection
using single-mode Fibre Channel cables between two long-wave GBICs or SFPs
that are inserted into the Fibre Channel switch port slots. Contact your IBM
technical-support representative if you require a remote mirror configuration with a
link distance greater than 10 Km (6.25 mi) or if you require protocol (for example,
FC-ATM-FC) conversion between remote mirror nodes.

Note: The IBM FASIT Storage Manager Version 8.2 software limits distances
between storage subsystems in a Fibre Channel environment to 10 Km (6.25
mi).

General performance considerations

10

Note the following general performance considerations when creating remote logical
drive mirrors.

» The controller owner of a primary logical drive performs a full synchronization in
the background while processing local I/O writes to the primary logical drive and
associated remote writes to the secondary logical drive. Because a full
synchronization diverts controller processing resources from I/O activity, this can
impact performance to the host computer program.
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To reduce the performance impact, you can set the synchronization priority to
establish how the controller owner prioritizes a full synchronization relative to
other I/O activity. The following are some basic guidelines to setting the
synchronization rate:

— A full synchronization at the lowest synchronization priority rate takes
approximately eight times as long as a full synchronization at the highest
synchronization rate.

— A full synchronization at the low synchronization priority rate takes
approximately six times as long as a full synchronization at the highest
synchronization rate.

— A full synchronization at the medium synchronization priority rate takes
approximately three and a half times as long as a full synchronization at the
highest synchronization rate.

— A full synchronization at the high synchronization priority rate takes
approximately twice as long as a full synchronization at the highest
synchronization rate.

For more information on setting the synchronization priority, refer to |Chapter 3,
[‘Using the Remote Mirror Option” on page 43

* When the mirror logical drive pair is in the Synchronization-in-Progress status, all
host computer write data is copied to the remote system in processing the I/O.
Controller I/0 bandwidth and I/O latency affect host computer write performance.
Host read performance is not affected by the mirror relationship.

* The overall system performance is impacted when data is copied from the
primary logical drive to the secondary logical drive and when the number of
writes permitted at one time are limited.

Using other premium features with the Remote Mirror Option

This section describes how you can use the Remote Mirror Option in conjunction
with other premium features available in version 8.2 of the storage-management
software.

Storage Partitioning premium feature

Storage Partitioning is a premium feature which enables host computers to share
access to logical drives in a storage subsystem. A storage partition is created when
you define a collection of host computers (a host group) or a single host computer
and then define a logical drive to logical unit number (LUN) map. This map enables
you to define what host group or host computer has access to a particular logical
drive in your storage subsystem.

|Figure 9 on page 12| shows the Mappings View of the Subsystem Management
window, where primary logical drive Accounting is included in a partition accessible
by host group Campus East, and secondary logical drive Accounting 2 is included in
a partition accessible by host group Campus West.

Chapter 1. Introduction 11



Storage Subsystem View Mappings Logical Drive Growp Logical Drive Controller Drive Help

TR

@ Logical Physical View I;jti Mappings View l

Topology : |Deﬁned Mappings
ES Stofa@ Subsyaem Midwest | Logical Drive Name Accessible By | LUN |Logical Drive Capacity| ~ Tiype
5 (5 Accounting  Host Group Campus East 1 5 GB Standard

i Undefined Mappings
5 % Ascounting 2 Host Group Gampus YWast 2 10GB Standard
Default Group

+ @ﬁ Host Group Campus East
+] Elﬁ Host Group Campus West

m@ Partitions Allowed/Used: 6412

Figure 9. Mappings View of the Subsystem Management window showing storage partitioning

The storage partition definitions for the primary and secondary storage subsystems
are independent of each other. If the storage partition definitions are put in place
while the logical drive is in the secondary role, the storage partition reduces the
administrative effort associated with storage subsystem recovery if it becomes
necessary to promote the secondary logical drive to the primary role. However,
depending on the host operating system and application, the secondary logical drive
might not be assigned to the same host that the primary logical drive is mapped to.
For more information on defining storage partitions, refer to the Subsystem
Management window online help.

Storage partition definitions can be performed using the Create command in the
Storage Manager Script window or the Command Line Interface (CLI). For more
information, refer to the Enterprise Management window online help.

FlashCopy logical drives

FlashCopy is a premium feature that comes with the IBM FAStT Storage Manager
software. You can enable this premium feature by purchasing the IBM FAStT
Storage Manager FlashCopy Option. A FlashCopy logical drive is a point-in-time
(real-time) image of a logical drive and is created so that a program, such as a
backup program, can access the FlashCopy logical drive and read the data while
the base logical drive remains online and accessible to host computers.

The logical drive on which the point-in-time image is created is known as the base
logical drive and must be a standard logical drive in the storage subsystem. For
remote logical drive mirroring, only the base logical drive of a FlashCopy logical
drive is permitted to be a candidate for the primary logical drive in a mirror
relationship. |Figure 10 on page 13| shows the primary logical drive (also the base
logical drive for the FlashCopy logical drive), the secondary logical drive, and the
FlashCopy repository logical drive in the Subsystem Management window for the
primary storage subsystem.
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Important: The base logical drive of a FlashCopy logical drive cannot be a
candidate for the secondary logical drive role in a mirror relationship. Otherwise, the
FlashCopy logical drive will fail when the remote mirror relationship is created.

Secondary logical drives are restricted from being the base logical drive for a
FlashCopy logical drive because the full synchronization process would fill the
FlashCopy repository logical drive, resulting in a failed FlashCopy logical drive.

{7 Logical/Physical View |
Logical

F& Storage Subsystem Primary Site

[:] Unconfigured Capacity (8.44 GB)

El% Logical Drive Group 1 (RAID 5)

~[EE Mirror Repository 1 (0.004GB)

[ Mirror Repository 2 (0.004GB)

a] Free Capacity (10.873 GB)

_| [_]__. Accounting (5 GB/0 GB usable) |
Accounting 2

[  Accounting-1 (5 GB)

| [ Accounting-R1 (0.466 GB)

W

FlashCopy logical drive
Secondary logical drive
Primary logical drive (also the basic logical drive

Figure 10. FlashCopy logical drive included in a mirror relationship

FlashCopy logical drive failure

When the FlashCopy Option is enabled, you can have FlashCopy logical drives
based on the primary logical drive of a mirrored logical drive pair.

If a role reversal is performed, and the primary logical drive is demoted to the
secondary logical drive status, all FlashCopy logical drives that are associated with
the demoted primary logical drive will show a Failed status.

Important: A secondary logical drive cannot be designated as the base logical drive
of a FlashCopy logical drive.

As shown in [Figure 11 on page 14} primary logical drive Accounting and secondary
logical drive Accounting 2 are displayed in the Logical View of the Subsystem
Management window for the primary storage subsystem. A FlashCopy logical drive
of primary logical drive Accounting was created.
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FlashCopy logical drive created, based
on Primary logical drive Accounting

Figure 11. FlashCopy logical drive associated with primary logical drive Accounting

If a role reversal is performed, primary logical drive Accounting is demoted to
secondary role status and the FlashCopy logical drive fails, as shown in
This is because the secondary logical drive Accounting 2 is considered the base
logical drive of the FlashCopy logical drive, which is not permitted.

[T Logical/Physical View |
Logical
Storage Subsystem Primary Site
“[7] Unconfigured Capacity (8.
j Unconfigured G y (8.44 GB)
& ogical Drive Group 1 5
=] Logical Drive G (RAID 5)
- [ Mirror Repository 1 (0.004GB)
- [ Mirror Repository 2 (0.004GB)
..... {5 Free Capacity (10.873 GB)
—| =1 @ Accounting (5 GB/0 GB usable) |
Accounting 2
_‘@ Accounting-1 (5 GB) |

-[f@ Accounting-R1 (0.466 GB)

Associated FlashCopy logical drive is failed.

Secondary logical drive Accounting 2 is
promoted to primary logical drive status.

Figure 12. FlashCopy logical drive failure due to role reversal
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If a FlashCopy logical drive fails as the result of a role reversal, you must perform
another role reversal to promote the secondary logical drive back to primary logical
drive status. After the role reversal is complete, the FlashCopy logical drive must be
recreated. For more information, refer to [Chapter 5, “Troubleshooting” on page 61|

Hardware and software requirements

This section describes the minimum software and hardware requirements needed to
install the Remote Mirror Option. A list of host bus adapters compatible with each
operating system is provided in the README file.

Hardware requirements

The following list contains the minimum hardware requirements needed when
configuring your system to use the Remote Mirror Option. The list includes
components that are supplementary to the standard requirements of a basic
storage-subsystem environment. For more information, refer to your IBM FAStT
Storage Manager Version 8.2 Installation and Support Guide.

» Two Netfinity FAStT500 RAID Controller Enclosure Units or IBM FAStT700
TotalStorage Fibre Channel storage subsystems. It is possible to have different
storage subsystems in each of the two nodes of the Remote mirror option. For
example, the local storage subsystem may be the IBM FAStT500 storage
subsystem and the remote storage subsystem may be the IBM FAStT700
storage subsystem and vice-versa. However, because the IBM FAStT500 and
IBM FAStT700 storage subsystems are different sets of hardware with different
performance characteristics, for optimal and reliable performance, the storage
subsystem and its associated drives and drive enclosures in each of the nodes of
the remote mirror setup must be the same.

* Fibre Channel switches - These devices are used to connect multiple host
computers with multiple storage subsystems in a controlled environment. You can
connect multiple Fibre Channel switches over a distance of up to 10 Km (6.25
mi) to create a fabric environment.

Refer to the README file for a list of certified Fibre Channel switches for use
with the Remote Mirror Option.

* Short or medium range Fibre Channel cables - To connect the host computers
and storage subsystems to the Fibre Channel switches.

* Long range Fibre Channel cables - These cables support distances up to 10 Km
(6.25 miles). These are used to connect between Fibre Channel Fibre Channel
switches to complete long distance fabrics.

* Fibre Channel host bus adapters (HBAs) - Refer to the README file for a list of
certified host bus adapters for use with the Remote Mirror Option.

Software requirements

When configuring your host computer to use the Remote Mirror Option, be sure the
following minimum software requirements are met:

» IBM FAStT Storage Manager Version 8.2x.xx
» Controller firmware version 5.20.xx
* IBM Remote Mirror Premium Feature Key (one for each storage subsystem)

Host operating systems

Host computers accessing mirrored logical drives must have one of the following
operating systems installed to use the Remote Mirror Option. Refer to the README
file for the latest operating system support.
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* Windows NT 4.0 Server Edition

* Windows 2000

» Solaris Version 2.6, 2.7 (Solaris 7), 2.8 (Solaris 8)
* HP-UX Version 11.0 or later

* Linux (Red Hat Version 7.x)

* Netware Version 5.1

Supported configurations

This section describes the three configurations that support the Remote Mirror
Option installation when you have IBM FAStT Storage Manager Version 8.2
software installed. The level of redundancy is determined by the type of
configuration you choose to use. Contact your IBM technical-support representative
if you require modifications to the configurations described below.

Highest Availability Campus configuration

16

The Highest Availability Campus configuration is fully redundant, includes two
storage subsystems and four Fibre Channel switches connected with a Fibre
Channel fabric, as shown in [Figure 13 on page 17| The primary storage subsystem
and secondary storage subsystem have a maximum connection distance of up to
10 Km (6.25 mi).

Note: For performance and high availability configuration, use two 10 Km (6.25 mi)
interswitch links (ISL).

For detailed instructions on setting up the Highest Availability Campus configuration,
refer to [Chapter 2, “Hardware and software installation” on page 21
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Figure 13. Dual-site, four-switch Highest Availability Campus configuration

Campus configuration

The Campus configuration, a lower-cost configuration, consists of two storage
subsystems and two Fibre Channel switches connected with a Fibre Channel fabric,

as shown in [Figure 14 on page 18| The primary storage subsystem and secondary

storage subsystem have a maximum connection distance of up to 10 Km (6.25 mi).

For detailed instructions on setting up the Campus configuration, refer to |Chapter 2,

[‘Hardware and software installation” on page 21|
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Figure 14. Dual-site, two-switch Campus configuration

Intra-site configuration
The Intra-site configuration, a low-cost configuration, consists of two storage
subsystems and two Fibre Channel switches connected with a Fibre Channel fabric
as shown in [Figure 15 on page 19|

The primary storage subsystem and secondary storage subsystem might have a
maximum connection distance of up to 500 m (0.32 mi), and can be located in the
same building or in the same room.

For detailed instructions on setting up the intra-site configuration, refer to |Chapter 2,
[‘Hardware and software installation” on page 21|
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Secondary storage subsystem

Hardware and software checklist

and the software checklist in[Table 3 on

Complete the hardware checklist in
page 20|to ensure that all the required hardware and software components are

configured properly.

Hardware checklist

Complete the following tasks before starting the storage-management software.

Table 2. Hardware checklist

Task description

Validation activity

Ensure that the minimum hardware requirements are met. For a
complete list of the hardware requirements, refer to
[requirements” on page 15}

] Completed

Ensure your primary and secondary storage subsystems are
properly configured. Refer to the appropriate storage subsystem
Installation and User’s Guide for configuration information and
refer to [Chapter 2, “Hardware and software installation” on|

|Qage 21

] Completed

Ensure that your Fibre Channel switches and cables are properly
configured. For more information on configuring Fibre Channel
switches for use with the Remote Mirror Option, refer to |Chapter 2,|
[Hardware and software installation” on page 21|

[] Completed

Software checklist

Complete the following software checklist tasks before defining mirror relationships

in your storage subsystems.

19
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Table 3. Software checklist

Task description

Validation activity

Ensure that data on the primary and secondary storage
subsystems participating in remote logical drive mirroring are
backed up.

[] Completed

Ensure that the correct version of firmware and
storage-management software are installed. For more information
on upgrading firmware or installing the storage-management
software, refer to the appropriate IBM FAStT Storage Manager
Installation and Support Guide, [Chapter 2, “Hardware and|
[software installation” on page 21} or the Subsystem Management
window online help.

[] Completed

Ensure that the Remote Mirror Option is enabled on both the
primary and secondary storage subsystems. For information on
enabling features, refer to|“Enabling and activating the Remote]
[Mirror Option” on page 43.

[] Completed

Ensure that the Remote Mirror Option is activated and that a
mirror repository logical drive is created for each controller on the
primary storage subsystem. For more information on activating
the Remote Mirror Option, refer to ['Enabling and activating the]
[Remote Mirror Option” on page 43|

[] Completed

Ensure that the required primary and secondary logical drives are
created on the primary and secondary storage subsystems. For
more information on establishing a mirror relationship, refer to
[Chapter 3, “Using the Remote Mirror Option” on page 43

[] Completed
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Chapter 2. Hardware and software installation

This chapter contains the information that you need to install the hardware and
software to run the Remote Mirror Option. The beginning of the chapter explores
the steps that you must complete before a hardware or software installation. Next,
hardware installation procedures are presented, followed by software installation
procedures. Complete the procedures in this chapter sequentially, from beginning to
end.

Pre-installation

This section provides necessary information, such as site preparation, hardware
and software requirements, and concepts that you must review and complete before
beginning the hardware or software installation procedures.

Site preparation

The Remote Mirror Option uses Fibre Channel Fibre Channel switches to create a
fabric environment for data replication. These Fibre Channel switches require only
minimal additional site preparation requirements beyond basic storage subsystem
operation.

For basic site preparation considerations including the use of Fibre Channel cables
and connections, refer to your IBM Netfinity FAStT500 Raid Controller Enclosure
Unit Installation Guide or your IBM TotalStorage FAStT700 Fibre Channel Storage
Server Installation Guide.

For additional site preparation considerations concerning the Fibre Channel Fibre
Channel switches, including power requirements and physical dimensions and
requirements, refer to the documentation that comes with the fabric switch.

Hardware and software requirements

Ensure that all of the required hardware and software are available before
proceeding. The list of these requirements is available in|[‘Hardware and software|
Irequirements” on page 15|

Switch zoning overview

All Fibre Channel switches do not need to be zoned exactly as presented in this
publication. The only zoning requirement is to zone the Remote Mirror host port
connections together. For example, you can create one zone consisting all primary
and secondary host port A2 and B2. You can create two zones - one zone consists
of primary and secondary host ports A2 and the other zone consists of primary and
secondary host ports B2. This is required to make sure that the host port of the
controller be fully dedicated for remote mirroring operations.

There is no zone requirements for the server HBA connections. However,
depending on the operating system, server HBA connections may be zoned so that
a single host bus adapter in a server can only access one controller per storage
subsystem.

Important: Do not zone the ISL port that connects (cascades) switches within a
fabric environment.
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Switch zoning configurations are set using the management software that comes
with the Fibre Channel switch.

When two or more Fibre Channel Fibre Channel switches are cascaded together,
the switch management software combines the ports for all Fibre Channel switches
that are linked. For example, if two 16-port Fibre Channel Fibre Channel switches
are cascaded with a physical connection with a Fibre Channel cable, the switch
management software shows ports 0 through 31 participating in the fabric, rather
than two Fibre Channel switches each with ports 0 through 15. Therefore, a zone
that is created containing any of these ports can exist on multiple cascaded Fibre
Channel switches.

In the top illustration in , the Fibre Channel switches are on the same
network and cascaded; therefore, Zone 1 is the same zone on Switch 1A as Zone 1
on Switch 1B. In the bottom illustration in , the Fibre Channel switches are
on the same network, but are not cascaded. Even though both contain a Zone 1
(shown as Zone A in Switch 2), these zones are independent of each other.
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Lgl [y
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nan o - o R TnEE = E E ©
Elll@@llm—fvr%llllllll
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Figure 16. Switch zoning in cascaded (top) and noncascaded (bottom) Fibre Channel
switches
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For more information about Fibre Channel switch zoning or setting up a zone
configuration, refer to the documentation that comes with the switch.

The switch zone settings for the three remote-mirror option configurations are
presented preceding each configuration in this chapter.

Hardware installation

This section describes the procedures necessary to properly connect and configure
one or more storage subsystems for use with the Remote Mirror Option. The three
configurations described in this section are as follows:

» Highest Availability Campus configuration - This is the preferred configuration
for the Remote Mirror Option. Four total Fibre Channel switches (two at each
site) provide complete redundancy in the Fibre Channel switches and fabrics
(with a ISL distance up to 10 Km (6.25 mi)) in addition to all storage subsystem
components and host computers. Therefore, the Highest Availability Campus
configuration is the preferred configuration because data synchronization can
continue for any single switch failure. Besides being a fully redundant
configuration, the Highest Availability Campus configuration is still preferred due
to disaster recovery implications. The single site creates a single point of failure if
a disaster affects the entire site. To begin installing hardware for this
configuration, go to[‘Highest Availability Campus configuration”]

» Campus configuration - This configuration is not fully redundant because the
number of Fibre Channel switches is reduced from four to two, and the number
of fabrics is reduced from two to one. Therefore, this makes the Fibre Channel
switches and fabrics the single point of failure. A switch failure does not usually
result in a loss of data, but does affect data synchronization until the error is
corrected. This configuration allows the minimum required components to

successfully operate the Remote Mirror Option between two sites up to 10 Km

(6.21 mi). To begin installing hardware for this configuration, go to
[configuration” on page 29|

 Intra-site configuration - This configuration is similar to the Campus
configuration in that there are only two Fibre Channel switches. However, no
multiple-switch fabrics exist in this configuration. Since all host computers and
storage subsystems are in proximity of both Fibre Channel switches, full
redundancy is obtained within the site since each controller path is connected to
a different switch. However, a single switch failure in this configuration can result
in a degraded mirror. To begin installing hardware for this configuration, go to
[‘Intra-site configuration” on page 34|

For a list of requirements to complete any hardware installation, refer to [Hardware]
fand software requirements” on page 15[

Highest Availability Campus configuration

Note: The Highest Availability Campus configuration is the preferred configuration
for the Remote Mirror Option.

This configuration has two Fibre Channel switches at both the primary and
secondary sites to provide complete failover and redundancy in Fibre Channel
switches and cables, in addition to any host or storage subsystem failure. Two Fibre
Channel switches at each site also provide redundancy to the local site in addition
to a fully redundant remote configuration. There is no single point of failure in the
hardware components.
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shows the Highest Availability Campus configuration after installation is

complete.
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Figure 17. Highest Availability Campus configuration

Switch zoning for the Highest Availability Campus configuration

24

This configuration provides a separate zone for each reserved port for the Remote
Mirroring Option.

The Fibre Channel switches do not need to be zoned exactly as presented in this
configuration. However, the following are requirements when zoning switches for the
Highest Availability Campus configuration.

» The Remote Mirror host port connections must be zones together. For example,
you can create one zone consisting all primary and secondary host port A2 and
B2. You can create two zones - one zone consists of primary and secondary host
ports A2 and the other zone consists of primary and secondary host ports B2.
This is required to make sure that the host port of the controller be fully
dedicated for remote mirroring operations.

* The uplink port must not be zoned on any Fibre Channel switch.
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* There are no zone requirements for the server host bus adapter (HBA)
connections. However, depending on the operating system, server HBA
connections can be zoned so that a single host adapter can access only one
controller per storage subsystem.

The Fibre Channel switches in contain 16 ports each, which leaves many
unused ports per switch. You can redistribute the remaining ports among the other
zones. However, it is preferred that most remaining ports be assigned to the zones
containing the host connections (Zones 1 and 2 in. This will allow easy
setup for additional host computers to connect to the environment.

shows how the four Fibre Channel switches are zoned for this Highest
Availability Campus configuration. The zones are configured on the switch to allow
one port per zone for a storage subsystem connection, and one port per zone for
each host. There are four zones in the following configuration example.

» Zones 1 and 3 exist on Fabric 1 (switch 1A at the primary site, and switch 1B at
the secondary site)

» Zones 2 and 4 exist on Fabric 2 (switch 2A at the primary site, and switch 2B at
the secondary site.
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Figure 18. Switch zoning for the Highest Availability Campus configuration

Before proceeding to the next section, ensure that all four Fibre Channel switches
are properly zoned according to the requirements and the zoning shown in

Figure 18] For more information on zoning Fibre Channel switches, see
zoning overview” on page 21|
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Cabling examples for the Highest Availability Campus configuration

Use [Table 4|and [Table 5| shows examples of the Fibre Channel cabling connections
in the Highest Availability Campus configuration. Use the examples as a reference

before you use the procedure in [‘Setting up the Highest Availability Campus|

lconfiguration” on page 27,

Table 4. Highest Availability Campus configuration connections (Primary site) examples

Primary site
Switch 1A Switch 2A
Zone Port Connection to and from: Zone Port Connection to and from:
1 0 Host 1, HBA 1 (HA1) 2 0 Host 2, HBA 2 (HB2)
1 Controller port A1 1 Host 1, HBA 2 (HA2)
2 Host 2, HBA 1 (HB1) 2 Controller port B1
3 Additional host, HBA 1 (optional) 3 Additional host, HBA 2 (optional)
4 Additional host, HBA 1 (optional) 4 Additional host, HBA 2 (optional)
5 Additional host, HBA 1 (optional) 5 Additional host, HBA 2 (optional)
6 Additional host, HBA 1 (optional) 6 Additional host, HBA 2 (optional)
7 Additional host, HBA 1 (optional) 7 Additional host, HBA 2 (optional)
3 8 Unused 4 8 Controller port B2 (dedicated
remote-mirror port)
9 Controller port A2 (dedicated 9 Unused
remote-mirror port)
10 Unused 10 Unused
11 Unused 11 Unused
12 Unused 12 Unused
13 Unused 13 Unused
N/A 14 Spare (can be added to either N/A 14 Spare (can be added to either
zone) zone)
N/A 15 Uplink with switch 1B N/A 15 Uplink with switch 2B

Table 5. Highest Availability Campus configuration connections (Secondary site) examples

Secondary

Switch 1B Switch 2B

Zone Port Connection from and to: Zone Port Connection from and to:

N/A 16 Uplink with Switch 2A N/A 16 Uplink with Switch 1A

N/A 17 Spare (can be added to either N/A 17 Spare (can be added to either

zone) zone)

1 18 Host 3, HBA 1 (HC1) 2 18 Controller port B1
19 Controller port A1 19 Host 4, HBA 2 (HD2)
20 Host 4, HBA 1 (HD1) 20 Additional host, HBA 1 (optional)
21 Additional host, HBA 1 (optional) 21 Host 4, HBA 2 (HD2)
22 Additional host, HBA 1 (optional) 22 Additional host, HBA 1 (optional)
23 Additional host, HBA 1 (optional) 23 Additional host, HBA 1 (optional)
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Table 5. Highest Availability Campus configuration connections (Secondary site) examples (continued)

Secondary
3 24 Unused 4 24 Controller port B2 (dedicated
remote-mirror port)
25 Controller port A2 (dedicated 25 Unused
remote-mirror port)
26 Unused 26 Unused
27 Unused 27 Unused
28 Unused 28 Unused
29 Unused 29 Unused
30 Unused 30 Unused
31 Unused 31 Unused

Important: Begin the installation at the primary site.

secondary site when instructed to do so.

Repeat these steps for the

Setting up the Highest Availability Campus configuration

Complete the following procedure to set up the Highest Availability Campus
configuration for the Remote Mirror Option.

Note: All connections are completed using Fibre Channel cables of appropriate

length.
1. Do one of the following:

* If you are adding the Remote Mirror Option hardware to an existing storage
subsystem environment that stops I/O from all host computers, go to step 2.

« If this is a new storage subsystem installation, go to step 3.

2. Power down all storage subsystems, host computers, Fibre Channel switches,
and all other hardware in the storage-subsystem environment.

3. Ensure that cabling between all storage subsystems and drive enclosures is

complete.

Note: Depending on which site you are configuring, Switch 1 represents
Switch 1A for the primary site and Switch 1B for the secondary site.
Repeat the same configuration for Switch 2.

4. Connect the primary host bus adapter (Hx1) for each local host to an available

port in Zone 1 of Switch 1 (Figure 19 on page 28).

Note: You can connect the cables to any port in the proper zone of the switch.
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Connect the secondary host bus adapter (Hx2) for each host at this site to an

available port in Zone 2 of Switch 2 (Figure 19).

Host Group
Host 1 Host 2

Step 4 | HA1 HA2| |HB1 HB2
I ciun s i

I Switch 1
0] [2][4][6]/8]l10[]12] [14]

Zone 1
1] (8] [s] (7)o fl11}13] 5]

Step 5]

Switch 2

—'@@
one
KN EENE B ENE E

Figure 19. Host bus adapter connections to Fibre Channel switches

6.

Connect controller port A1 of the storage subsystem to an available port in
Zone 1 of Switch 1 (Figure 20 on page 29).

Connect controller port B1 of the storage subsystem to an available port in
Zone 2 of Switch 2 (Figure 20 on page 29).
Connect controller port A2 of the storage subsystem to an available port in
Zone 3 of Switch 1 (Figure 20 on page 29).

Connect controller port B2 of the storage subsystem to an available port in
Zone 4 of Switch 2 dFigure 20 on page 29b.

Note: Controller ports A2 and B2 are reserved for mirror relationship
synchronization upon activation of the Remote Mirror Option. For more
information, see [‘Connectivity and 1/0” on page 8}

Switch 1

(o] [2][4][e]]8][10][12] [14]

Zone 1

ERERENEENEINENE

Step 6/"_ 4—Step 8

Step7—»| |[$—Step9

I | Switch 2
(o] [2] (4] (&) 8 frol12] [ra]

Zone 2
(18] [s] [7])Lo Jl11]13f [15]
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Figure 20. Storage subsystem connections to the Fibre Channel switches

10. If the primary site cabling and the secondary site cabling is complete, go to
step 11. Otherwise, repeat steps 1 through 9 for the secondary site.

11. Complete the Fabric 1 environment for Switch 1 by connecting Switch 1A with
Switch 1B. Connect each end of a long range Fibre Channel cable (that can
support a distance up to 10 Km (6.25 mi)) to an unzoned port in each switch

shown in [Figure 21

12. Repeat step 11 for Switch 2A and 2B to complete the Fabric 2 environment for
Switch 2 shown in

Switch 1A Fabric 1 Switch 1B

o o ] 10Kmmax [ ey

@@»)_/\/—(o

Zone 1 Zone 1
(1] [3] [5] [7] 1o} [11]]13] [15<

Step 11
Switch 2A Fabric 2 Switch 2B

10 Km max

@@»»_/\/—(e

Zone 2 Zone 2
(113 [s] (7)o Fl11fl13] [1514

Step 12

Figure 21. Connecting switches over a remote network to complete Fabric 1 and Fabric 2
environments

13. Cabling for this Highest Availability Campus configuration is complete. Repeat
step through step |10 for any additional storage subsystems that
exist in the same rack that uses the Remote Mirror Option.

14. Power up all storage subsystems, host computers, Fibre Channel switches,
and any other hardware at both sites that were powered down in step 2.

15. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to
installation” on page 39

Campus configuration

The Campus configuration offers the same functionality as the Highest Availability
Campus configuration, but contains only one switch at each site, rather than two.
The configuration is still redundant for host bus adapters, controllers, and remote
logical drive mirroring ports, but is a single point of failure for Fibre Channel
switches. If a switch at either site fails, the Remote Mirror Option cannot function.
For this reason, the Highest Availability Campus configuration is highly preferred for
total environment redundancy. [Figure 22 on page 30| shows the Campus
configuration after installation is complete.
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B8 Host Fibre Channel cable
@@ Storage subsystem Fibre Channel cable
@—@® Dedicated remote mirror option cable

*»))——e= Fabric uplink Fibre Channel cable (ISL)

Figure 22. Campus configuration

Switch Zoning for the Campus configuration

30

This configuration provides a separate zone for each reserved port for the Remote
Mirroring Option.

The Fibre Channel switches do not need to be zoned exactly as presented in this
configuration. However, the following are requirements when zoning switches for the
Highest Availability Campus configuration.

» The Remote Mirror host port connections must be zones together. For example,
you can create one zone consisting all primary and secondary host port A2 and
B2. You can create two zones - one zone consists of primary and secondary host
ports A2 and the other zone consists of primary and secondary host ports B2.
This is required to make sure that the host port of the controller be fully
dedicated for remote mirroring operations.

* The uplink port must not be zoned on any Fibre Channel switch.

» There are no zone requirements for the server host bus adapter (HBA)
connections. However, depending on the operating system, server HBA
connections can be zoned so that a single host adapter can access only one
controller per storage subsystem.

The Fibre Channel switches in |Figure 23 on page 31|contain 16 ports each, which
leaves many unused ports per switch. You can distribute the remaining ports among
the other zones. However, it is preferred that most remaining ports be assigned to
the zones containing the host connections (Zone 1 in [Figure 23 on page 31). This
allows easy setup for additional host computers to connect to the fabric
environment.
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There are a total of four zones in this configuration.

— All zones will exist on the Fabric 1 environment (Switch 1A at the primary site,
and Switch 1B at the secondary site).

— Zones 3 and 4 are reserved for the dedicated Remote Mirror Option
connections.

Figure 23| shows how the two Fibre Channel switches are zoned for the Campus
configuration.

Switch 1A Fabric 1 Switch 1B

—————————————————————————————————————————————————————————————————————

@Z@ >
one one
(1 ]3] (s ]17 18 Jlt1] [13] {154

Figure 23. Switch zoning for the Campus configuration

Before proceeding to the next section, ensure that both Fibre Channel switches are

roperly zoned according to the requirements and the zoning example shown in
Figure 23[ For more information on zoning Fibre Channel switches, see
zoning overview” on page 21|.

Cabling examples for the campus configuration

Use [Table 6|and [Table 7 on page 32| as a cabling reference before you use the
procedure in |“Setting up the Campus configuration” on page 32|.

Table 6. Campus configuration connections (Primary site) examples

Primary site

Switch 1A

Zone Port Connection to and from:

1 Host 1, HBA 1

Controller port A1

Host 2, HBA 1

Additional host, HBA 1 (optional)

Additional host, HBA 1 (optional)

Additional host, HBA 1 (optional)

Host 1, HBA 2

Controller port B1

N O|Oa|p~|lOINM|=]|O

Host 2, HBA 2

©

Additional host, HBA 2 (optional)

e
o

Additional host, HBA 2 (optional)

—_
—_

Additional host, HBA 2 (optional)

w
-
N

Controller port A2 (dedicated remote-mirror port)
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Table 6. Campus configuration connections (Primary site) examples (continued)

Primary site

4 13 Controller port B2 (dedicated remote-mirror port)
N/A 14 Spare

N/A 15 Uplink with Switch 2

Table 7. Campus configuration connections (Secondary site) examples

Secondary site

Switch 1B
Zone Port Connection to and from:
1 16 Uplink with Switch 1
17 Spare
18 Host port, HBA 1
19 Controller port A1
20 Host 4, HBA 1
21 Additional host, HBA 1 (optional)
22 Additional host, HBA 1 (optional)
23 Additional host, HBA 1 (optional)
2 24 Host 3, HBA 2
25 Controller port B1
26 Host 4, HBA 2
27 Additional host, HBA 2 (optional)
28 Additional host, HBA 2 (optional)
29 Additional host, HBA 2 (optional)
30 Controller port A2 (dedicated remote-mirror port)
31 Controller port B2 (dedicated remote-mirror port)

Important: Begin the installation at the primary site. Repeat these steps for the
secondary site when instructed to do so.

Setting up the Campus configuration

Complete the following procedure to set up the Campus configuration for the
Remote Mirror Option.

Note: All connections are completed using Fibre Channel cables of appropriate
length.

1. Do one of the following:

* If you are adding Remote Mirror Option hardware to an existing storage
subsystem environment that stops 1/0 from all host computers, go to step 2.

* If this is a new storage subsystem installation, go to step 3.

2. Power down all storage subsystems, host computers, Fibre Channel switches,
and all other hardware in the storage subsystem environment.

3. Ensure that basic cabling between all storage subsystems and drive
enclosures is complete.
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Important: Depending on which site is configured, Switch 1 represents Switch
1A for the primary site, and Switch 1B for the secondary site.

4. Connect the primary host bus adapter (Hx1) for each host at this site to an
available port in Zone 1 of Switch 1, as shown in

Note: You can connect the cables to any port in the proper zone of the switch.

5. Connect the secondary host bus adapter (Hx2) for each host at this site to an
available port in Zone 2 of Switch 1 as shown in|Figure 24]

Host Group
Host 1 Host 2

HA1 HA2//HB1 HB2,
L] Lot

I

—Step 5

| |
—

Step 4=| |

Switch 1A

@Z@
one
@-|

LZone 3
Zone 4

Figure 24. Host bus adapter connections to Fibre Channel switches

6. Connect controller port A1 of the storage subsystem to an available port in
Zone 1 of Switch 1 as shown in

7. Connect controller port B1 of the storage subsystem to an available port in
Zone 2 of Switch 1 as shown in

8. Connect controller port A2 of the storage subsystem to an available port in
Zone 3 of Switch 1 as shown in

9. Connect controller port B2 of the storage subsystem to an available port in
Zone 4 of Switch 1 as shown in

Note: Controller ports A2 and B2 are reserved for mirror relationship
synchronization upon activation of the Remote Mirror Option. For more
information, see [‘Connectivity and I/O” on page 8

Switch 1A

o] (2] ] [e)fe]d
one
7 (3] [5)[7] (s ]

Step Gjl/y L‘Zone 3
Step 7 Zone 4

téstep 8
£ B‘Z Step 9
Wil gojojo
Al A2

Figure 25. Storage subsystem connections to Fibre Channel switches
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10. The primary site cabling is now complete. If the secondary site cabling is
complete, go to step 11. Otherwise, repeat steps 1 through 9 for the secondary
site.

11. Complete the Fabric 1 environment by connecting Switch 1A with Switch 1B.
Connect each end of a long range Fibre Channel cable (that can support a

distance of up to 10 Km (6.25 mi)) to an unzoned port in each switch, as
shown in [Figure 26,

__________________ Switch 1A___ Fabricl ______________________Switch1B
! 10 Km max

|o) 2 [e] (W Jholfiz] 4

\ one 1

| 9]

1 I

““““““““““ 1faaag2§“ < ““““““““““““““‘1: Zone 3
Zone 4 Step 11 Zone 4

Figure 26. Connecting Fibre Channel switches over a remote network to complete the Fabric
1 environment

12. Cabling for this Campus configuration is complete. Repeat step
through step for any additional storage subsystems that exist in the same

rack that will use the Remote Mirror Option.
13. Power up all storage subsystems, host computers, Fibre Channel switches,

and any other hardware at both sites that were powered down in step

14. Hardware installation is complete. The next step is to configure the storage
management software to support mirror relationships. Go to
installation” on page 39

Intra-site configuration

34

This configuration is used in environments where a long distance fabric is not
required due to the close proximity of the host computers and storage subsystems.
The configuration is still redundant for host bus adapters, controllers, remote logical
drive mirroring ports, and Fibre Channel switches, but is a single point of failure for
the site since all hardware can be destroyed by a single disaster. For this reason,
the Highest Availability Campus configuration is highly preferred for total
environment redundancy.

Important: A switch failure in this configuration does not affect data access;
however, an unsynchronized mirror state might occur as a result.

[Figure 27 on page 35| shows the Intra-site configuration after installation is
complete.
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Figure 27. Intra-site configuration

Switch zoning for Intra-site configuration

Intra-site configuration is designed for switch redundancy. However, the Fibre
Channel switches are not cascaded, and therefore are independent of each other.
This configuration provides a separate zone for each reserved port for the Remote
Mirroring Option.

The Fibre Channel switches do not need to be zoned exactly as presented in this
configuration. However, the following are requirements when zoning switches for the
Highest Availability Campus configuration.

* The Remote Mirror host port connections must be zones together. For example,
you can create one zone consisting all primary and secondary host port A2 and
B2. You can create two zones - one zone consists of primary and secondary host
ports A2 and the other zone consists of primary and secondary host ports B2.
This is required to make sure that the host port of the controller be fully
dedicated for remote mirroring operations.

» The uplink port must not be zoned on any Fibre Channel switch.

* There are no zone requirements for the server host bus adapter (HBA)
connections. However, depending on the operating system, server HBA
connections can be zoned so that a single host adapter can access only one
controller per storage subsystem.

Note: [Figure 28 on page 36| illustrates that there is no relationship between Zone A
and Zone B in Switch 2 and Zones 1 and 2 in Switch 1.

The Fibre Channel switches shown in|Figure 28 on page 36| contain 16 ports each,
which leaves many unused ports per switch. You can distribute the remaining ports
among the other zones. However, it is preferred that most remaining ports be
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assigned to the zones containing the host connections (Zone 1 and Zone A shown
in [Figure 28). This provides an easy set up for additional host computers to connect
to the environment.

There are a total of four zones in this configuration.
e Zones 1 and 2 will exist on Switch 1.
* Zones A and B will exist on Switch 2.

In|Figure 28, the Fibre Channel switches use half of the ports for each zone for
simplicity, although Zone 2 and Zone B require fewer ports.

Switch 1 Switch 2

@@ @A@
one one

(1] (3] [s][7]1o]l11]113[15 [11[3][s][7][e]l11]113] 15

Figure 28. Switch zoning for the Intra-site configuration

Before proceeding to the next section, ensure that both Fibre Channel switches are
properly zoned according to the requirements and the zoning example shown in
Figure 28] For more information on zoning Fibre Channel switches, see ['Switch|
zoning overview” on page 21}

Cabling examples for the intra-site configuration

Use and as a cabling reference before you use the procedure in [‘Setting up
he Intra-site configuration” on page 37

Table 8. Intra-site configuration connection examples

Switch 1 Switch 2
Zone Port Connection to and from: Zone Port Connection to and from:
1 0 Host 1, HBA 1 (HA1) A 0 Host 1, HBA 2 (HA2)
1 Controller port A1 (primary storage 1 Controller port B1 (primary
subsystem) storage subsystem)
2 Host 2, HBA 1 (HBH1) 2 Host 2, HBA 2 (HB2)
3 Controller port A1 (secondary 3 Controller port B1 (secondary
storage subsystem) storage subsystem)
4 Host 3, HBA 1 (HC1) 4 Host 3, HBA 2 (HC2)
Additional host, HBA 1 (optional) 5 Additional host, HBA 2
(optional)
Host 4, HBA 1 (HD1) 6 Host 4, HBA 2 (HD2)
Additional host, HBA 1 (optional) 7 Additional host, HBA 2
(optional)
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Table 8. Intra-site configuration connection examples (continued)

Switch 1 Switch 2
2 8 Unused B 8 Unused
9 Controller port A2 (primary storage 9 Controller port B2 (primary
subsystem - dedicated storage subsystem -
remote-mirror port) dedicated remote-mirror port)
10 Unused 10 Unused
11 Controller port A2 (secondary 11 Controller port B2 (secondary
storage subsystem - dedicated storage subsystem -
remote-mirror port) dedicated remote-mirror port)
12 Unused 12 Unused
13 Unused 13 Unused
14 Unused 14 Unused
15 Unused 15 Unused

Setting up the Intra-site configuration

Complete the following procedure to set up the Intra-site configuration for the
Remote Mirror Option.

Note: All connections are completed using Fibre Channel cables of appropriate
length.

1. Do one of the following:

« If you are adding Remote Mirror Option hardware to an existing storage
subsystem environment that stops 1/0 from all host computers, go to step 2.

« If this is a new storage subsystem installation, go to step 3.

2. Power down all storage subsystems, host computers, Fibre Channel switches,
and all other hardware in the storage subsystem environment.

3. Ensure that basic cabling between all storage subsystems and drive
enclosures is complete on both storage subsystems.

4. Connect the primary host bus adapter for each host (Hx1) to an available port
in Zone 1 of Switch 1, as shown in

Note: You can connect the cables to any port in the proper zone of the switch.

Host 1 Host2 | —Step 4¥ Host 3 Host 4

HAT*HAZ | HB14HB2 *Hc1 HC2 ®HD1 HD2
e
@@ @@
one one
(1] [3] [5] [7] {9} [11] [13] [15] 1] [3] [5] [7][9 ] [11} [13} (15|

Switch 1 Switch 2

Figure 29. Primary host bus adapter (Hx1) connection to the Fibre Channel switches
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5.

Connect the secondary host bus adapter (Hx2) for each host to an available
port in Zone A of Switch 2, as shown in

Host 1 Host 2 ,7 Step 5——_ |  Host3 Host 4

HA1 HA24HB1 HB2*] ‘HoPHC2 | HDPHD2
L] ]| L [

@@ @@

one one
1 [8) [s] [7]{o 11} i3] |15 ENERERE) ENENERNE
Switch 1 Switch 2

Figure 30. Secondary host bus adapter (Hx2) connection to the Fibre Channel switches

6.

Connect controller port A1 of the of the primary storage subsystem to an
available port in Zone 1 of Switch 1, as shown in
Connect controller port B1 of the of the primary storage subsystem to an
available port in Zone A of Switch 2, as shown in|Figure 31|

Connect controller port A2 of the of the primary storage subsystem to an
available port in Zone 2 of Switch 1, as shown in|Figure 31
Connect controller port B2 of the of the primary storaie subsystem to an

available port in Zone B of Switch 2, as shown in|Figure 31|

Note: Controller Ports A2 and B2 are reserved for mirror relationship
synchronization upon activation of the Remote Mirror Option. For more
information, see [‘Connectivity and 1/0” on page 8|

Switch 1 Switch 2
@@ @@
one one
][] [5] [7] 1911/ ]13] [15] EREREREENENENE
Step 6 1
epO—s «—Step 8 4«—Step 9
Bi B2
gojoo /i) 0/gjoo
Al A2
Step 7
Primary storage subsystem Secondary storage subsystem

Figure 31. Primary storage subsystem connections to Fibre Channel switches

10.

11.

12.

Connect controller port A1 of the of the secondary storage subsystem to an
available port in Zone 1 of Switch 1, as shown in|Figure 32 on page 39|.

Connect controller port B1 of the of the secondary storage subsystem to an
available port in Zone A of Switch 2, as shown in|Figure 32 on page 39l

Connect controller port A2 of the of the secondary storage subsystem to an
available port in Zone 2 of Switch 1, as shown in|Figure 32 on page 351
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13. Connect controller port B2 of the of the secondary storage subsystem to an
available port in Zone B of Switch 2, as shown in .

Switch 1 Switch 2
@@ @@
one 1 one
(1] (3] [5] [7]{9f{11[113}{15] EMERENE N RRERNE
Step 11 ?
Step 10— A > 4—Step 13
Bl B2 B B2
g0 gj0|o[o Step 12 g0 gjooio
Al A2 Al 2
Primary storage subsystem Secondary storage subsystem

Figure 32. Secondary storage subsystem connections to Fibre Channel switches

14. Cabling for this Intra-site configuration is complete. Repeat step |4 on page 37
through step for any additional storage subsystems that exist in the same

rack cabinet that uses the Remote Mirror Option.

15. Power up all storage subsystems, host computers, Fibre Channel switches and
any other hardware that was powered down in step [2 on page 37

16. Hardware installation is complete. The next step is to configure the storage

management software to support mirror relationships. Go to
‘

installation”]

Software installation

The Remote Mirror Option is a premium feature that is included as part of the IBM
FAStT Storage Manager 8.2 installation. However, the option is not enabled or
activated by default after installation. You must purchase an IBM Storage Manager
Remote Mirror Option for each storage subsystem in your remote mirror
configuration. This option contains a GenKey file that will enable the Remote Mirror
Option premium feature. If you want to purchase the Remote Mirror Premium
Feature Option, contact your IBM technical-support representative.

Important: All storage subsystems participating in mirror relationships must have
firmware level 05.2x.xx.xx or higher installed. For more information about upgrading
firmware and installing the storage-management software, refer to your appropriate
IBM FASIT Storage Manager Version 8.2 Installation and Support Guide.

For more information about enabling or activating the Remote Mirror Option, refer to
I'Enabling and activating the Remote Mirror Option” on page 43

Verifying installation and configuration

All hardware and software is now set up to support mirror relationships through the
Remote Mirror Option. However, before creating mirror relationships, ensure that all
required components are working properly.

Complete the following procedure for each storage subsystem that is participating in
any aspect of a mirror relationship to verify correct configuration.

1. Start the storage-management software.
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10.
11.

For more information about starting the storage-management software, refer to
your IBM FAStT Storage Manager Version 8.2 Installation and Support Guide
for operating-system specific procedures.

If this is the first time you have started the storage-management software, do
the following:

+ Click OK when prompted for Automatic Discovery of devices.
* Ensure that all storage subsystems designated to participate in mirror

relationships are displayed in the Device Tree view of the Enterprise
Management Window.

Note: If the storage subsystems do not appear, refer to[Chapter 5,
[‘Troubleshooting” on page 61|

« If this is not the first time you started the storage-management software, do
the following:
a. From the Enterprise Management Window, click Tools » Automatic
Discovery.
Click OK.
Verify that all storage subsystems designated to participate in mirror
relationships are displayed in the Device Tree view of the Enterprise
Management Window.
d. If the storage subsystems do not appear, refer to|Chapter 5,
[Troubleshooting” on page 61|
From the Enterprise Management window, select a storage subsystem that will
participate in mirror relationships.
Click Tools » Manage Device to open the Subsystem Management window
for that storage subsystem.
From the Subsystem Management window, click Help » About.
Verify that the version of the storage-management software is 08.2x.xx.xx or
later. If this requirement is not met, refer to your IBM FAStT Storage Manager
Version 8.2 Installation and Support Guide for storage-management software
upgrade procedures.
Click OK.
From the Subsystem Management window, click View » Storage subsystem
Profile.
Under the All tab, verify that the current firmware version is 05.2x.xx.xx or later.
If this requirement is not met, refer to IBM FAStT Storage Manager Version 8.2
Installation and Support Guide for firmware upgrade procedures.
When your installation is completed, refer to the following online help systems:
* Enterprise Management window help - Use this online help system to learn
more about working with the entire management domain.
* Subsystem Management window help - Use this online help system to learn
more about managing individual storage subsystems and remote mirror
option.

You can access these help systems from within the Storage Manager 8.2
Client. From either a Enterprise Management or Subsystem Management
window, click Help or press F1.

Click Close.

Observe the Remote Mirror Option icon in the status area. The icon represents
the Disabled and Deactivated status of the Remote Mirror Option.
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12. To begin working with Mirror Relationships, go to|Chapter 3, “Using the]
[Remote Mirror Option” on page 43,
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Chapter 3. Using the Remote Mirror Option

This chapter contains the procedures for completing the major tasks associated with
the Remote Mirror Option. The chapter is organized sequentially; after the Remote
Mirror Option premium feature key is purchased, you can enable and activate the
option so you can create and maintain mirror relationships. The final section is
provided for reference only and might be useful when a mirror relationship is no
longer needed.

Enabling and activating the Remote Mirror Option

The Remote Mirror Option premium feature key must be purchased before you can
enable the option. The option must be activated by using a GenKey program before
you can create any mirror relationships. First, determine the status of the Remote
Mirror Option. Then, enable and activate it.

Determining Remote Mirror Option status

There are four possible statuses of the Remote Mirror Option: Disabled/
Deactivated, Disabled/Activated, Enabled/Deactivated, and Enabled/Activated.

Important: The Remote Mirror Option must be in the Enabled/Activated state on
the secondary storage subsystem as well as the primary storage subsystem to
create and maintain mirror logical drive pairs.

You can determine the current status by hovering the mouse pointer over the
Remote Mirror Option icon in status area of the Subsystem Management window,
as shown in

- % Logical Drive Group 4 (RAID 5)
: a 5 (84.602 GB)

E% Logical Drive Group 5 (RAID 5)
i) 6(67.681GB)

[1%% [75,] Remote Logical Drive Mirroring - Disabled/Deactivated

Figure 33. Remote Mirror Option status

Important: The Remote Mirror Option status for the primary storage subsystem is
managed independently from the secondary storage subsystem. To determine the
status for both storage subsystems, select each storage subsystem independently,
then determine the status.

Remote Mirror Option statuses are as follows:

» Disabled and deactivated - No function of the Remote Mirror Option can be
performed. Full Remote Mirror Option functionality is not available until the option
is enabled and activated. The icon for this state is displayed in the Premium
Feature status area as a cylinder with a mirrored reflection. The icon has a red
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slash through it to show it is Disabled, and is greyed out to show it is
deactivated. An example of this state is illustrated in|Figure 33 on page 43| For
more information about enabling the Remote Mirror Option, refer|“Enabling the|
[Remote Mirror Option”} To activate the option, go to [‘Activating the Remote|
[Mirror Option’}

Disabled and activated - The Remote Mirror Option is disabled, preventing new
mirror relationships from being created. However, any pre-existing mirror
relationships are maintained with all functions of the Remote Mirror Option. For
more information about enabling the Remote Mirror Option, go to
|Remote Mirror Option”| The icon displayed for this state is similar to the
Disabled/Deactivated state, because the red slash remains to show the option is

disabled. However, the cylinder and its reflection now appear green to show the
option is active.

Enabled and deactivated - The Remote Mirror Option is enabled, but not
activated. To activate the option, go to |“Activating the Remote Mirror Option”| The
icon displayed for this state is similar to the Disabled/Deactivated state, because
the cylinder and its reflection remain grey. However, the red slash no longer
appears to indicate that the option is enabled.

Enabled/Activated - The Remote Mirror Option is enabled and active. You can
create and maintain mirror relationships. For more information about creating a
mirror relationship, go to [‘Creating mirror relationships” on page 46| The icon for
this state is displayed in the Premium Feature status area as a green cylinder
with a mirrored reflection.

Enabling the Remote Mirror Option

If the current status of the Remote Mirror Option is Disabled/Deactivated or
Disabled/Activated, complete the following steps to enable the Remote Mirror
Option.

1.

From the Subsystem Management window, click Storage subsystem -
Features » Enable.

The Select Feature Key File window opens.

Note: The Select Feature Key File program filters for files with the .key
extension. For more information about the feature key, refer to the
instructions on the IBM FAStT Storage Manager Version 8.2 Remote
Mirror Option Premium Feature Key CD.

Select the folder in which you placed the generated key file.
Select the appropriate key file, and then click OK.

The Enable Feature window opens.

Click Yes.

The Remote Mirror Option is now enabled. The icon in the Premium Feature
status area no longer displays a red slash. To further verify the status of the
option, click Storage subsystem > Features ~ List.

Do one of the following:

« If the Remote Mirror Option has not been activated, go to[“Activating the

[Remote Mirror Option’}
+ If the Remote Mirror Option is activated, go to [‘Creating mirror relationships’]

b page 46

Activating the Remote Mirror Option

Activating the Remote Mirror Option prepares the storage subsystem to create and
configure mirror relationships. When the option is activated, ports A2 and B2 of the
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storage controller become reserved and dedicated to Remote Mirror Option usage.
In addition, a mirror repository logical drive is created for each controller in the
storage subsystem.

If the current status of the Remote Mirror Option is Enabled/Deactivated, complete
the following procedure to activate the option:

1. From the Subsystem Management window, click Storage subsystem -
Remote Mirror > Activate.

The Activate Remote Logical Drive Mirroring - Introduction window opens.

Note: Click Back at any time to change information in previous window.

2. Decide where the mirror repository logical drives will reside. Select one of the
following.

* Use free capacity on existing arrays - If this option is selected, then a
corresponding logical drive must be selected also.

a. Select a logical drive.
b. Select Finish or Next.
c. Go to step 6.
* Create a new array using unconfigured capacity - If this option is selected,
more information must be collected about the new logical drive. Go to step
3.
3. In the Create New Array window, select the RAID level for the new logical
drive.
4. Under the drive selection choices, select one of the following.
« Automatic - The drives are chosen automatically according to available
capacity.
* Manual - This option gives the user the option to specify which drives
contain the mirror repository logical drive.
a. Press and hold the Ctrl key and click to select the drives you want to
include in your array.

b. Click Apply.

Important: If the RAID level for the new array is RAID 1, then the number of
drives must be an even number. If an odd number of drives are selected, an
error message will display when you click Apply.

5. Click Next.

6. Review the information in the Preview window and click Finish if all
information is satisfactory.

7. Do one of the following:
 |f the storage subsystem password is protected, go to step 8.
* Go to step 9.

8. Enter the password and click OK.

9. Review the information in the Completed window and click OK to finish the
Remote Mirror Option activation.
The Remote Mirror Option must be enabled and activated on all storage
subsystems that are part of a remote mirror setup. The icon in the Premium
Feature status area changes from grey to green. If this is not the case, repeat
the steps in|“Enainng and activating the Remote Mirror Option” on page 43| for

each storage subsystem that has the remote mirror option disabled and
deactivated.
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10. Continue with [‘Creating mirror relationships’]

Creating mirror relationships

Before you create mirror relationships, be sure that the Remote Mirror Option is
enabled and activated.

Note: The secondary host ports on the storage subsystems are reserved for data
synchronization between a primary and secondary logical drive of a mirror
relationship.

Creating logical drives for mirror relationships

Before you create mirror relationships, be sure that logical drives must exist at both
the primary and storage subsystems. The logical drive of the remote mirror pair that
is presented to the host is the primary logical drive. The storage subsystem that the
primary drive resides in is called the primary storage subsystem. Similarly, the
logical drive residing in the secondary storage subsystem is the secondary logical
drive.

If a primary or secondary logical drive does not exist, you must create one on the
corresponding storage subsystem.

Consider the following when creating a logical drive:

* The secondary logical drive must be of equal or greater size than the primary
logical drive.

* The RAID level of the secondary logical drive does not have to be the same as
that of the primary logical drive.

For more information about creating logical drives, refer to the Subsystem
Management window online help.

When logical drives exist at both sites, you can create mirror relationships by using
the Remote Logical Drive Mirror Wizard.

Creating a mirror relationship using the Create Remote Logical Drive
Wizard

The Create Remote Logical Drive Mirror Wizard enables a user to create a mirror
relationship between a primary logical drive and a secondary logical drive. Before
beginning the wizard, ensure the following requirements are met:

* The Remote Mirror Option is enabled on both storage subsystems in which the
primary and secondary logical drives will reside.
* The Remote Mirror Option is activated on both subsystems.

* The storage subsystems are connected through a proper Fibre Channel fabric
configuration.

» The secondary logical drive must be at equal or greater size than the primary
logical drive.
» There must be management connections to both the primary and secondary

storage subsystems. The Enterprise Management window must display both
primary and secondary storage subsystems in the management domain.

* The remote Fibre Channel switch connections are made between the primary
and secondary storage subsystems. The Fibre Channel switches are zoned so
that the controller host ports are by themselves.
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When these requirements are met, continue with the following procedure to create a
mirror relationship:

1.

10.

11.

In the Logical/Physical View of the Subsystem Management window, select the
logical drive that will become the primary logical drive in the mirror relationship.
Click Logical Drive » Remote Mirror » Create.

Click Next.

Follow the instructions in the Select Remote Storage subsystem window.

The Create Remote Logical Drive Mirror window opens stating requirements

similar to those mentioned at the beginning of this section.

a. Select the proper storage subsystem. The remote mirror option supports a
maximum of two storage subsystems per configuration. The Wizard will
display all available storage subsystems within the management domain
that has remote mirror option enabled and activated. If you have an
existing remote mirror relationship with a given storage subsystem, do not
select another storage subsystem from the list.

b. Click Next.

Select the logical drive that will become the secondary logical drive in the
mirror relationship. If there are no logical drives listed, the secondary storage
subsystem that you selected do not have logical drives with enough capacity
available to mirror the selected logical drive.

Click Next.
Select the Synchronization Priority Level.

Note: For more information about the Synchronization Priority Level, refer to
[‘Changing the Synchronization Priority Level” on page 49,

Click Finish.

If the remote storage subsystem is password protected, enter the password

and click OK.

If you do not exceed the maximum number of mirrored logical drive pairs that
can be created for the storage subsystem, You are prompted to create another
mirror logical drive pair by the Create Remote Logical Drive mirror wizard. If
you do not want to create another mirror logical drive pair, click No and go to
step 11. Otherwise, do the following:

a. Select the logical drive that will become the next primary logical drive.

b. Click Next.

c. Repeat step Elthrough step [10 on page 47| for each additional mirror

relationship.

Review the information in the Completed window, then Click OK to complete
the Create Remote Logical Drive Mirror wizard.

The primary and secondary logical drives are now displayed with the mirror
relationship icons, which will change slightly upon completion of the data
synchronization. The amount of time required for the data to be synchronized
between the two logical drives varies proportionally to the size of the logical drive
being mirrored and storage subsystem /O loads. After the synchronization is
complete, the icons will change to the optimal state mirror relationship icons.

[Figure 34 on page 48| shows how the icons appear during and after data

synchronization.

Note: To view all icons associated with the Remote Mirror Option and a description

of their purpose, refer to the Subsystem Management window online help.
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with synchronizing data with fully synchronized data

Figure 34. Synchronizing and Optimal Mirror Relationship

The mirror relationship is now created and optimal.

Continue to ['Maintaining mirror relationships’|

Maintaining mirror relationships

When a mirror relationship is active, you can modify certain attributes of the
relationship at any time. This section describes how to view information about the
mirror relationship, how to change the synchronization priority level, how to remove
a mirror relationship, and how to delete logical drives participating in a mirror
relationship.

Viewing mirror relationships

48

The mirror relationship that exists between the primary logical drive and the
secondary logical drive can be examined by various methods, such as using the
storage subsystem profile, the Mirroring Properties window, and the View
Associated Components window.

Displaying the storage subsystem profile

The storage subsystem profile is the most efficient way to view information about
any or all components of the storage subsystem. Details for all logical drives, such
as the primary, secondary, and Mirror Repository logical drives can all be easily
viewed through the storage subsystem profile. The storage subsystem profile also
contains specific information for components associated with mirror relationships.

Complete the following procedure to display the storage subsystem profile.

1. From the Subsystem Management window click View » Storage subsystem
profile.

2. Click the Logical Drives tab.

» To view information about the mirror relationships that exist on this storage
subsystem, click the Mirrors tab.

» To view information about the mirror repository logical drive, click the
Repositories tab.

Note: Click Save As to save all of the information shown in the storage subsystem
profile as a .txt file. The Save Profile window that opens will provide the
option of saving the current window, multiple windows, or the entire Storage
subsystem profile.

The Mirroring Properties window
The Mirroring Properties window displays all the physical characteristics of a single
logical drive in the mirror relationship.

IBM FAStT Remote Mirror Option: Installation and User’s Guide



The window displays the same information as the storage subsystem profile for the
selected logical drive, but is specific only to that logical drive. In addition, the
synchronization progress is displayed if the selected logical drive is synchronizing
data with another logical drive in a newly defined mirror relationship or in an
existing mirror relationship after the broken mirror link is restored.

Complete the following procedure for each logical drive that needs to be examined
in the mirror relationship. You can also use the following procedure to view the
synchronization progress of a recently created mirror relationship.

1. Select the primary or secondary logical drive.
2. Click Logical Drive » Properties.
3. Click the Mirroring tab.

The View Associated Components window

The View Associated Components window provides a graphical representation of
the logical drives participating in the mirror relationship. In addition, details are
provided for all components, rather than just the logical drive initially selected.

Compilete the following procedure to view all associated components in a mirror
relationship, including primary, secondary, and Mirror Repository logical drives.

1. Select the primary or secondary logical drive in a mirror relationship.

2. From the right mouse pop-up menu, select View Associated Components.
The View Associated Components window opens.

3. Click Close to exit the window.

Changing the Synchronization Priority Level

The Synchronization Priority Level of a mirror relationship defines the amount of
system resources used to synchronize the data between the primary and secondary
logical drives of a mirror relationship. If the highest priority level is selected for a
mirror relationship, the data synchronization uses a high amount of system
resources to increase mirror performance, but might decrease performance for all
other functions, including other mirror relationships. If the lowest synchronization
level is selected, there is less impact on complete system performance, but the
mirror relationship synchronization might be slower.

To change the Synchronization Priority Level for a mirror relationship, complete the
following procedure:

1. In the Logical/Physical view of the Subsystem Management window, select a
primary logical drive of a mirror relationship.

2. Click Logical Drive » Remote Mirror > Change > Synchronization Priority.

The Change Synchronization Priority window opens. The primary logical drive
chosen in step 1 is selected by default in the Select logical drives selection
area.

3. Select one or more logical drives.

4. Select the synchronization priority level. The 5 levels are Lowest, Low, Medium,
High, and Highest. All selected logical drives will change to the same
synchronization priority level.

5. Click OK.
6. Click Yes when the Confirmation window opens.
7. Click OK when the Completed window opens.
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Removing mirror relationships

Removing a mirror relationship between a primary and secondary logical drive does
not affect any of the existing data on either logical drive. The link between the
logical drives is removed, but the primary logical drive still continues normal 1/0
operation. You can perform this action for backup routines, particularly from the
secondary logical drive. A mirror relationship between the two logical drives can be
recreated unless one of the logical drives is deleted.

To remove a mirror relationship between two logical drives, complete the following
procedure.

1. From the Subsystem Management window, select a local primary logical drive
or local secondary logical drive of a mirror relationship.

2. Click Logical Drive ~ Remote Mirror >~ Remove Mirror Relationship.

The Remove Mirror Relationship window displays all mirror relationships
associated with this storage subsystem.

3. Select one or more mirror relationships to be removed.
4. Carefully review the information presented in the Confirmation window.
5. Click Yes.

Deleting primary and secondary logical drives

Deleting a logical drive participating in a mirror relationship removes the mirror
relationship and completely deletes the logical drive from the storage subsystem.
The mirror relationship cannot be redefined until a new logical drive is created or an
alternate logical drive replaces the deleted logical drive.

To delete a primary or secondary logical drive from a mirror relationship, complete
the following procedure:

Attention:

» If you have data or logical drives that you want to keep, do not click Configure »
Reset Configure. This will reset the controller unit and delete all
previously-configured logical drives.

* You must delete operating system logical drives using Disk Administrator before
deleting logical drives or resetting the configuration in Storage Manager 8.2. This
will avoid damage to your registry information.

* The following steps will permanently remove data from the selected logical drive.

1. From the Subsystem Management window, select the primary or secondary
logical drive that you want to delete.

2. Click Logical Drive » Delete.

3. Carefully review the information. To delete the logical drive, in the text area
type:
Yes

4. Click OK.

Deactivating and disabling the Remote Mirror Option

If no mirror relationships exist and the Remote Mirror Option is no longer required,
then deactivating the option will reestablish normal use of dedicated ports on both
storage subsystems and will delete both mirror repository logical drives.
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The Remote Mirror Option can also be disabled. When the option is in the
Disabled/Active state, previously existing mirrors can still be maintained and
managed; however, new mirror relationships cannot be created. When in the
Disabled and Deactivated state, no Remote Mirror Option activity occurs.

Deactivating the Remote Mirror Option

To change the Remote Mirror Option status from Enabled and Activated to Enabled
and Deactivated or from Disabled and Activated to Disabled and Deactivated,
complete the following procedure.

1. Verify that all mirror relationships are removed. For more information, refer to
[‘Removing mirror relationships” on page 50}

2. Click Storage subsystem > Remote Mirror > Deactivate.
3. Carefully review the information presented in the Confirmation window.
4. Click Yes.

Disabling the Remote Mirror Option

To change the Remote Mirror Option status from Enabled and Deactivated to
Disabled and Deactivated or from Enabled/Activated to Disabled/Activated,
complete the following procedure.

Attention: When you disable the remote mirror premium feature, you will require
the key file generating utility to reenable the feature. Copy the key file to a diskette
or directory for later use. The key file is required to reenable the Remote Mirror
Option.

1. Complete the procedure in [‘Deactivating the Remote Mirror Option”| prior to
disabling the Remote Mirror Option.

2. From the Subsystem Management window, click Storage subsystem -
Features - Disable.

Click Remote Mirror.

Click OK.

Carefully review the information presented in the Confirmation window.
Click Yes.

o o~ W
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Chapter 4. Disaster recovery

This chapter describes the actions to take to prepare for a disaster, the actions to
take if a hardware component failure occurs, and the actions to take if a complete
site failure occurs.

As businesses increasingly require around-the-clock data access, system
administrators are required to ensure that critical data is safeguarded against
potential disasters.

In preparing for a potential disaster, system administrators must develop a disaster
recovery plan that details the procedures to prepare for and prevent disasters, and
the actions required to respond to and recover from disasters if they occur.

Planning for disaster recovery

This section provides information on steps that must be taken in preparation for a
possible disaster or unrecoverable error. Preparation steps include backing up
critical data prior to and during remote logical drive mirroring, using host clustering
software for failover protection, and preparing the secondary storage subsystem
that will participate in the remote logical drive mirror.

Be sure that you complete the checklist in [Table 2 on page 19| and[Table 3 on|
page 20|to ensure that your primary and secondary storage subsystems are
prepared correctly.

Backing up critical data

Backing up critical data regularly is vital to insure against disasters or unrecoverable
error. Backups must be performed regardless of whether the Remote Mirror Option
is in use.

A backup of all critical data on both the primary and secondary storage subsystems
participating in remote logical drive mirroring must be performed prior to creating a
remote logical drive mirror. Periodic backups of the primary storage subsystem must
be carried out when remote logical drive mirrors are in use.

You can make backups to tape or disk while 1/0O continues using FlashCopy, which
captures a point-in-time image of a logical drive. For more information on using
FlashCopy logical drives, refer to [‘FlashCopy logical drives” on page 12 or the
Subsystem Management window online help.

Preparing the secondary storage subsystem

When preparing for a potential disaster, ensure that the secondary storage
subsystem to which the data is mirrored, is structured in the same manner as the
primary storage subsystem.

Prior to creating a remote logical drive mirror, prepare your secondary storage
subsystem to ensure that storage partitions and FlashCopy logical drives are
defined and ready to function if the secondary storage subsystem is promoted to
the primary role.

Defining storage partitioning
The Storage Partitioning feature enables you to define which host computers have
access to which logical drives on the storage subsystem and at what logical unit
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number. When configuring your secondary storage subsystem, replicate the storage
partitions that were previously defined on the primary storage subsystem. This will
ensure that if a role reversal is carried out, host computers are able to access their
required data. Depending on your operating system and host application software,
you might not be able to map the secondary logical drive to the host that the
primary logical drive is mapped to.

For more information on the Storage Partitioning feature, refer to the Subsystem
Management window online help.

Ensuring failover protection using the host clustering software

Host failover clustering is a process in which the operating system and program
software work together to provide continuous availability in the event of a program
failure, hardware failure, or operating-system error. Software products that support
remote failover might refer to global or geographic cluster management.

You can use the Remote Mirror Option in conjunction with remote host failover to
provide complete redundancy of host computers and storage subsystems. If a
disaster occurs at the primary storage subsystem, host computers at the secondary
storage subsystem will take over the processing and initiate a role change to the
secondary storage subsystem.

Remote failover is not a requirement for a disaster recovery plan. Depending on the
requirements for how quickly operations must be functioning at Optimal status
again, mirroring the storage subsystems and depending on manual startup of the
remote host computers might be acceptable.

For more information on host cluster software and configuration, refer to the
README in your IBM FAStT Storage Manager Version 8.2 CD.

Disaster preparation checklist
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Complete the tasks listed to ensure access to mirrored data is possible in the event
of a disaster or unrecoverable error.

Table 9. Disaster recovery preparation checklist

Task description Validation activity

1. Ensure that all critical data is backed up on both the primary | [] Task 1 completed.

and secondary storage subsystems. [ Task 2 completed.

2. Ensure that your storage partitioning is in place on the
secondary storage subsystem. This will reduce any lag time [] Task 3 completed.
when promoting a secondary logical drive to the primary logical
drive role.

For more information on setting up storage partitioning, refer to
the Subsystem Management window online help.

3. Ensure that, if required, your host clustering software is
configured to allow host failover between the primary storage
subsystem and secondary storage subsystem participating in
remote logical drive mirroring.

For more information, refer to your host clustering software
documentation.
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Recovering from switch failures

The High Availability Campus configuration is the only configuration where each
switch is a single point of failure. In all other configurations, if a switch fails, at least
one other switch is configured to be an alternate path for all I/O. The single switch
at each site is not only responsible for the communication between the two sites for
the Remote Mirror Option, but for all host to storage subsystem I/O as well.

If a switch fails in the High Availability Campus configuration, the system
administrator must decide whether or not to do a complete site failover. This
decision must be based on the immediate availability of a backup switch or the time
it will take to receive a replacement.

If a replacement switch is not readily available, one of the following temporary
scenarios will need to occur until the switch is replaced.

» Direct connection between host computers and storage subsystems - This
will bypass the switch and allow normal 1/O to continue. All mirror relationships
are suspended until a normal configuration is resumed. Since the storage
subsystems have a finite number of host connections, all host computers might
not be able to access the storage subsystem. For information on how to directly
connect host computers and storage subsystems, refer to your IBM Netfinity
FAStT500 Raid Controller Enclosure Unit Installation Guide or IBM TotalStorage
FAStT700 Fibre Channel Storage Server Installation Guide.

» Entire site failover - The switch at the secondary site is still functional, which
enables all host computers to access the switch and storage subsystems. Mirror
relationships are suspended until the primary storage subsystem is recovered. If

a complete site failover is needed to continue normal operations, see |‘Entire site
[failover procedure}

Recovering from storage subsystem failures

This section provides procedures for recovering storage systems when one of the
following situations has occurred:

* The primary storage subsystem is damaged or destroyed
* The entire primary site is damaged or destroyed

Both situations require a complete site failover from the primary site to the
secondary site so that normal operations can continue. For a secondary site failure,
no site failover is necessary. If the primary logical drive is not damaged, then a full
synchronization will occur when the site is recovered. If the primary storage

subsystem is damaged, follow the procedure in[‘Rebuild a damaged site procedure’]
on page 56

Attention: The procedures in this section must be completed in the order
presented to ensure that the affected site or storage subsystem is recovered
successfully.

Entire site failover procedure
Entire site failover is necessary when an event occurs that inhibits normal operation
to the primary site for an extended period of time.

1. Manually reverse the role of the primary logical drive of the mirror relationship to
the secondary role. For more information, see [‘Reversing the roles of primary|
[and secondary logical drives” on page 57}
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If storage partitioning is pre-configured so hosts can access the logical drives,
go to step 4. Otherwise, continue with step 3.

Configure the storage partitioning so that host to logical drive access is identical
to the primary site configuration. When configured, continue to step 4. For more
information on setting up storage patrtitioning, refer to the Subsystem
Management window online help.

If the host computers at the secondary site are properly configured for host
failover, go to step 6. Otherwise, continue with step 5.

Reinstall host software and reconfigure settings as needed. For more
information about installing and configuring host software, refer to the
documentation that comes with the software.

Run the Hot_add utility on hosts that have only mapped logical drives from the
secondary storage subsystem. Restart all hosts that have logical drive mappings
from the primary and secondary storage subsystems; then, Resume normal
operation with the secondary site acting as a new, fully-functioning primary site.

If storage partitioning is pre-configured so that proper host computers can
access appropriate logical drives, go to step 6. Otherwise, go to step 5.

The entire site failover is complete. The primary site must now be reconfigured
and the Remote Mirror environment must be recreated. The next step will
depend on the resulting status of the storage subsystem from the disaster.

If the storage subsystem and all of the contained data is recovered and fully
operational, go to [‘Recreate a mirror relationship procedure” on page 57|
Otherwise, go to|‘Rebuild a damaged site procedure’|

Rebuild a damaged site procedure

If a disaster occurs to the primary or secondary site that renders the storage
subsystem or all data on the storage subsystem irreparable, then the site needs to
be rebuilt with new hardware.

56

Complete the following procedure to rebuild a damaged site:

1.

Obtain new storage subsystems and any host computers and hardware needed
to properly use the Remote Mirror Option. Be sure that the new hardware has
the latest level of specifications than the damaged hardware.

Depending on the configuration, complete the switch zoning and hardware
installation procedure as presented in ['Hardware installation” on page 23} for
this site only.

Define a logical drive to replace the mirrored logical drive damaged on the
original storage subsystem. Be sure that the new logical drive is identical to the
specifications of the previously damaged logical drive.

Ensure storage partitioning is properly defined so that it can take over normal
operation from the secondary site. For more information on setting up storage
partitioning, see I‘Using other premium features with the Remote Mirror Option”|
|on page 11[

Ensure the host software is properly configured so that the host computers can
take over I/O from the secondary site host computers. For more information
about installing and configuring host software, refer to the documentation that
comes with the software.

The site is recovered and is now ready to resume any mirror relationships that
were active before the failure. Go to ['‘Recreate a mirror relationship procedure’]

fon page 57
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Recreate a mirror relationship procedure

When the damaged site is back online and properly configured, mirror relationships
can be resumed.

Recreate a mirror relationship by completing the following procedure.

1. From the active secondary site, define a mirror relationship using the logical
drive on the recovered primary site as the primary logical drive. For more
information, see |“Creating mirror relationships” on page 46|.

2. Ensure Storage Partitioning is properly defined on the recovered primary site so
that it can take over normal operation from the secondary site. For more
information on setting up storage partitioning, see |“Using other premiuml
|features with the Remote Mirror Option” on page 11|or refer to the online help.

3. Ensure the host software is properly configured so that the host computers at
the recovered primary site can take over I/O from the secondary site host
computers. For more information about installing and configuring host software,
refer to the documentation provided with the software.

4. Perform a manual role reversal so that the recovered primary site now
possesses the active primary logical drive, and the primary logical drive now
exists on the secondary site. For more information, see [‘Reversing the roles of|
[primary and secondary logical drives’}

5. The Remote Mirror configuration is now optimal.

Reversing the roles of primary and secondary logical drives

A role reversal is the process of promoting the secondary logical drive to be the
primary logical drive within the mirrored logical drive pair, and demoting the primary
logical drive to be the secondary logical drive.

A role reversal is performed using one of the following methods:

+ Changing a secondary mirrored logical drive to a primary logical drive. This
option promotes a selected secondary logical drive to become the primary logical
drive of the mirrored pair, and is used when an unrecoverable error has occurred.
For step-by-step instructions, refer to ['‘Changing a secondary logical drive to a

» Changing a primary mirrored logical drive to a secondary logical drive. This
option demotes a selected primary logical drive to become the secondary logical
drive of the mirrored pair, and is used during normal operating conditions. For
step-by-step instructions, refer to[“Changing a primary logical drive to al
[secondary drive” on page 58|

Role reversals can also be performed using the Set Command in the Storage
Manager Script window or the CLI. For more information, refer to the Enterprise
Management window online help.

Changing a secondary logical drive to a primary drive

A secondary logical drive is usually promoted to a primary logical drive role when
an unrecoverable error has occurred on the storage subsystem that contains the
primary logical drive, and the primary logical drive needs to be promoted so that
host computers can access data and normal operations can continue.

This option is not available unless the Remote Mirror Option is activated.
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Note: When the secondary logical drive becomes a primary logical drive, any host
computers that are accessing the logical drive through a logical drive-to-LUN
mapping will now be able to read or write to the logical drive. Note that this
condition applies if the host did not have the same logical-drive-to-LUN
mapping as the LUN in the primary logical drive that was demoted to
secondary logical drive. If it did, you must restart the host for the
newly-promote-to-primary (secondary) logical drive to replace the demoted
(primary) logical drive.

If a communication problem between the secondary site and primary site prevents
the demotion of the primary logical drive, an error message displays. However, you
are given the opportunity to proceed with the promotion of the secondary logical
drive, even though this will lead to a Dual Primary Remote Mirror status condition.
The recovery for the Dual Primary Remote Mirror status condition occurs when
remote mirror pairs are recreated. If you attempt to change the role of one of the
primary drives, an error will occur.

Complete the following procedure to promote a secondary logical drive to the
primary logical drive role:

1. Select the secondary logical drive in the Logical View and then, select either the
Logical Drive > Remote Mirror > Change » Role to Primary pull-down menu
option, or Change ~» Role to Primary from the right-mouse pop-up menu. The
Change to Primary window opens.

2. Click Yes. The secondary logical drive is promoted to be the primary logical
drive role in the remote logical drive mirror.

When the controller owner of the primary logical drive is contacted, the primary
logical drive is automatically demoted to be the secondary logical drive role in
the remote logical drive mirror.

Changing a primary logical drive to a secondary drive

58

Changing a primary logical drive to the secondary logical drive role is used for role
reversals during normal operating conditions. You can also use this option during a
recovery procedure when a dual primary remote mirror status condition occurs.

Role reversal will not occur unless the Remote Mirror Option is activated.

Important: Any host computers that are accessing the primary logical drive through
a logical drive-to-LUN mapping will no longer be able to read or write to the logical
drive. When the primary logical drive becomes a secondary logical drive, only
remote writes initiated by the primary controller is written to the logical drive.

If a communication problem between the primary and secondary sites prevents the
demotion of the primary logical drive, an error message displays. However, you are
given the opportunity to proceed with the demotion of the primary logical drive, even
though this will lead to a Dual Secondary Remote logical drive mirror status
condition.The recovery for the Dual Primary Remote Mirror status condition occurs
when remote mirror pairs are recreated. If you attempt to change the role of one of
the primary drives, an error will occur.

Attention: If the selected primary logical drive has associated FlashCopy logical
drives, demoting this logical drive to a secondary role will cause the associated
FlashCopy logical drives to fail.

To demote a primary logical drive to the secondary logical drive role, do the
following:
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Select the primary logical drive in the Logical View; then, select either the
Logical Drive » Remote Mirror > Change » Role to Secondary pull-down
menu option, or Change » Role to Secondary from the right-mouse pop-up
menu. The Change to Secondary window opens.

Click Yes. The primary logical drive is demoted to be the secondary logical drive
in the remote logical drive mirror.

When the controller owner of the primary logical drive is contacted, the
secondary logical drive is automatically promoted to be the primary logical drive
in the remote logical drive mirror.

Chapter 4. Disaster recovery 59



60 IBM FASIT Remote Mirror Option: Installation and User’s Guide



Chapter 5. Troubleshooting

This chapter provides information about troubleshooting some commonly
encountered problems when using the Remote Mirror Option.

Troubleshooting topics include general remote logical drive mirroring problems,
inappropriate Fibre Channel fabric configurations, problems with storage subsystem
components involved in remote logical drive mirroring, and basic switch
troubleshooting. Also provided is a list of the critical events that might be generated,
and instructions for upgrading future versions of controller firmware.

Locate the section that directly relates to your problem or consult the section
describing general troubleshooting techniques. If your problem is not discussed in
any of the sections in this chapter, contact technical support.

General troubleshooting

This section describes some of the usual problems that might be encountered when
using the Remote Mirror Option. The information is presented in order from the time
the option is enabled and activated, to problems that might be encountered
completing normal tasks when using the Remote Mirror Option.

Information about the probable cause and resolution of each problem is provided. If
your problem is not addressed in this section, refer to the remaining sections in this
chapter before contacting technical support.

Problem Cause Resolution

The Remote Mirror menu options in The Remote Mirror Option is not 1. Enable the Remote Mirror Option.
the Subsystem Management window | enabled or activated. A premium feature key is required
are greyed out and unavailable. to enable premium features.

2. Activate the Remote Mirror
Option.

The Remote Mirror Option is a
premium feature option. Contact your
IBM Technical Service Representative
for purchase information. For
step-by-step instructions on enabling
and activating the Remote Mirror

Option, refer to |“Enab|ing and|

[activating the Remote Mirror Option’]

lon page 43| or to the Subsystem

Management window online help.
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Problem

Cause

Resolution

The Remote Mirror icon in the
premium feature status area is greyed
out with a red line.

The Remote Mirror Option is not
enabled or activated.

1. Enable the Remote Mirror Option.
A premium feature key file is
required to enable the feature.

2. Activate the Remote Mirror
Option.

The Remote Mirror Option is a
premium feature option. Contact your
IBM Technical Service Representative
for purchase information. For
step-by-step instructions on enabling
and activating the Remote Mirror
Option, refer to |“Enab|ing and|
|activating the Remote Mirror Option’)|

|gn page 4§| or the Subsystem

Management window online help.

When creating a remote logical drive
mirror, an error message displaying
the following code:

INVALID_MIRROR_CANDIDATE_VOL

The secondary logical drive candidate
was participating in a mirror
relationship with a different logical
drive on this storage subsystem. The
mirror relationship was successfully
removed from the other storage
subsystem. However, a
communication error prevented the
successful removal of the mirror
relationship on this storage
subsystem.

A logical drive on this storage
subsystem still has a mirror
relationship defined with the
secondary logical drive.

1. Click the View ~» Storage
subsystem Profile option, and
click the Logical Drives tab and
then the Mirrors tab.

2. Locate the logical drive that is still
participating in the mirror
relationship with the secondary
logical drive candidate and
remove the mirror relationship.
For step-by-step instructions, refer
to FRemoving mirror relationships’

lon page 50| or to the Subsystem

Management window online help.

3. Re-create the intended remote
logical drive mirror using the
original candidate logical drives.
For step-by-step instructions, refer
to [‘Creating mirror relationships’]

fon page 46| or to the Subsystem

Management window online help.

The primary logical drive is showing a
Synchronization-in-Progress status.

A full synchronization, between the
primary and secondary logical drives
participating in a mirror relationship, is
in progress. Data available on the
primary logical drive is copied in its
entirety to its associated secondary
logical drive.

Wait for the full synchronization to
complete. When full synchronization
has finished copying data from the
primary logical drive to the secondary
logical drive, the mirrored logical drive
pair transitions to a Synchronized
status.

For more information on monitoring
the status of a remote logical drive
mirror, refer to the Subsystem
Management window online help.
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Problem

Cause

Resolution

Both the primary and secondary
logical drive are displayed as being
the primary logical drive.

A disaster or unrecoverable error has
occurred on the storage subsystem
containing the primary logical drive,
and the secondary logical drive is
promoted to the primary logical drive
role.

The primary storage subsystem is
now operational, but unreachable
because of a link failure. A forced
promotion of the secondary logical
drive has resulted in both the primary
and secondary logical drives is
displayed in the primary logical drive
role.

If the mirror logical drive pair status is
synchronized, perform steps 1 and 2.
Otherwise, perform steps 3 and 4.

1. Determine which of the logical
drives in the mirrored logical drive
pair must be the primary logical
drive.

2. Choose the logical drive that must
be in the secondary logical drive
role, then click Storage
subsystem » Change - Role to
Secondary pull-down menu
option. A resynchronization will
automatically occur.

3. Delete the mirror relationship from
either storage subsystem by
highlighting either primary logical
drive in its respective Subsystem
Management Window and
selecting the Logical Drive »
Remote Mirroring »+ Remove
Mirror Relationship menu option.
Note: The mirror relationship for
the remote logical drive will not be
removed if there is a connection
problem between the two storage
subsystems. If the mirror
relationship remains on the
remote logical drive after the
above action, highlight that logical
drive from its respective
Subsystem Management Window
and select the Logical Drive -
Remote Mirroring » Remove
Mirror Relationship menu option.

4. In its respective Subsystem
Management Window, highlight
the logical drive you wish to be
the primary logical drive and
select the Logical Drive »
Remote Mirroring > Create
menu option. Follow the
instructions in the Create Remote
Mirror wizard to re-create the
mirror relationship

For step-by-step instructions, refer to

“Changing a primary logical drive to a

secondary drive” on page 58 or to the

Subsystem Management window
online help.
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Problem

Cause

Resolution

Both the primary and secondary
logical drives are displayed as being
the secondary logical drive.

In response to a dual primary logical
drive condition, a role reversal was
carried out and the primary logical
drive was demoted to the secondary
logical drive role. The secondary
storage subsystem is operational, but
unreachable because of a link failure.
The forced demotion of the primary
logical drive has resulted in both the
primary and secondary logical drives
that are displayed in the secondary
logical drive role.

If the mirror logical drive pair status is
synchronized, perform steps 1 and 2.
Otherwise, perform steps 3 and 4.

1. Determine which of the logical
drives in the mirrored logical drive
pair must be the primary logical
drive.

2. Choose the logical drive that must
be in the primary logical drive
role, then click Storage
Subsystem » Change - Role to
Primary pull-down menu option. A
re-synchronization will
automatically occur.

3. Delete the mirror relationship from
either storage subsystem by
highlighting either secondary
logical drive in its respective
Subsystem Management Window
and selecting the Logical Drive -
Remote Mirroring »+ Remove
Mirror Relationship menu option.
Note: The mirror relationship for
the remote logical drive will not be
removed if there is a connection
problem between the two storage
subsystems. If the mirror
relationship remains on the
remote logical drive after the
above action, highlight that logical
drive from its respective
Subsystem Management Window
and select the Logical Drive ~»
Remote Mirroring » Remove
Mirror Relationship menu option.

4. In its respective Subsystem
Management Window, highlight
the logical drive you wish to be
the secondary logical drive and
select the Logical Drive -
Remote Mirroring > Create
menu option. Follow the
instructions in the Create Remote
Mirror wizard to re-create the
mirror relationship.

For step-by-step instructions, refer to

“Changing a secondary logical drive|

to a primary drive” on page 57|or to

the Subsystem Management window
online help.
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Problem

Cause

Resolution

The primary logical drive/secondary
logical drive are displayed as missing.

A physical logical drive on which a
remote logical drive mirror depends
(primary logical drive, secondary
logical drive) is removed, and the
logical drive is now displayed under
the missing logical drives node in the
Logical View of the Subsystem
Management window.

If missing logical drives are detected
because drives have accidentally
been removed, or are detected as
missing because of a loss of power to
the drive enclosures, recovery of
these logical drives is possible by:

1. Re-inserting the drives back into
the drive enclosure.

2. Ensuring that the drive enclosure
power supplies are properly
connected to an operating power
source and have an Optimal
status.

For more information, refer to
Recovery Guru or contact your IBM
technical-support representative.

If the missing logical drive is no
longer required, it can be deleted.

Attention: Deleting a missing
logical drive is a permanent action.
Any associated logical drives or
logical drive-to-LUN mappings will
also be deleted. For more
information, refer to the Recovery
Guru or to the Subsystem
Management window online help.

The mirror relationship was removed
successfully from the primary side,
but not from the secondary side.

When removing a mirror relationship,
a link failure occurred between the
primary and secondary storage
subsystems and an error message
displays.

The Subsystem Management window
for the primary storage subsystem
indicates that the mirror relationship is
removed successfully; however, the
Subsystem Management window for
the secondary storage subsystem
indicates that the mirror relationship
still exists.

Open the Subsystem Management
window for the secondary storage
subsystem and remove the mirror
relationship.

For step-by-step instructions, refer to

“Removing mirror relationships” on|

page 50| or the Subsystem
Management window online help.
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Problem

Cause

Resolution

The mirror relationship was removed
successfully from the secondary side,
but not from the primary side.

When removing a mirror relationship,
a link failure occurred between the
primary and secondary storage
subsystems.

The Subsystem Management window
for the secondary storage subsystem
indicates that the mirror relationship is
removed successfully; however, the
Subsystem Management window for
the primary storage subsystem
indicates that the mirror relationship
still exists, with the primary logical
drive showing an Unresponsive
status.

Open the Subsystem Management
window for the primary storage
subsystem and remove the mirror
relationship.

For step-by-step instructions, refer to

“Removing mirror relationships” on|

page 50| or to the Subsystem
Management window online help.

The primary logical drive is showing
an Unsynchronized status.

The remote logical drive mirror is in
an Unsynchronized status because
the data mirrored between the
primary logical drive and secondary
logical drive is no longer identical.
Usual causes for this status include
link errors, a failed primary logical
drive or secondary logical drive, or a
dual primary or dual secondary error
condition.

While the remote logical drive mirror
is in an Unsynchronized status, no
mirroring activity will take place.
Note: The remote mirror link and the
mirror logical drive pair status
depends on I/O requests, especially
I/O write requests to the primary
logical drive. If there are no 1/O, the
displayed status of the mirror link and
the mirror logical drive pair in the IBM
FASIT Storage Manager client might
not be incorrect. Generate I/O write
requests to the primary logical drive
to force the storage subsystems
updating the remote mirror status.

When the controller owner of the
primary logical drive can
communicate with the controller
owner of the secondary logical drive
and the logical drive is online and
optimal, a full synchronization will
automatically take place. When a full
synchronization begins, the remote
logical drive mirror transitions to a
Mirror Synchronization-in-Progress
status.

For information on monitoring the
status of a remote logical drive mirror,
refer to the Subsystem Management
window online help.
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Problem

Cause

Resolution

Error message indicates that the
Remote Mirror Option is out of
compliance.

The Remote Mirror Option is out of
compliance. This normally occurs if a
storage subsystem with logical drives
participating in remote logical drive
mirroring is moved into the primary
storage subsystem and one of the
following conditions now exists:

* The Remote Mirror Option is not
enabled on the selected storage
subsystem.

* The Remote Mirror Option is
enabled, but the current number of
remote logical drive mirrors defined
on the primary storage subsystem
exceeds the number of mirror
relationships allowed for this
storage subsystem.

If the Remote Mirror Option is not
enabled for the primary storage
subsystem:

1. Obtain a premium feature key for
this feature from your IBM
technical-support representative.

2. Enable the Remote Mirror Option.
For step-by-step instructions, refer
to ['Enabling the Remote Mirror|
[Option” on page 44} or to the
Subsystem Management window
online help.

If the Remote Mirror Option is
enabled, but the current number of
mirror relationships on the storage
subsystem exceeds the number of
mirror relationships allowed for the
storage subsystem, reduce the
number of mirror relationships to
equal or less than the number of
mirror relationships allowed. The
maximum number of mirror
relationships allowed is 32.

For step-by step instructions, refer to

“Removing mirror relationships” on|

page 50|or to the Subsystem
Management window online help.

The remote logical drive candidate is
unresponsive and cannot be updated.

The primary storage subsystem is
unable to notify the secondary
storage subsystem that its world wide
name (WWN) has changed.

This might be the result of a controller
in the primary storage subsystem
being swapped or removed. Storage
subsystem recovery procedures that
result in configurations being reset
can also cause a change to the
WWN.

The first write to the primary logical
drive will cause the mirrored logical
drive pair to transition into an
Unsynchronized status.

1. Remove all the existing mirror
relationships from the primary
storage subsystem. For
step-by-step instructions, refer to
“Removing mirror relationships” on|
page 50]or to the Subsystem
Management window online help.

2. Re-establish the required mirror

relationships. For step-by ste
instructions, refer to[‘Creatin
[mirror relationships” on page 46| or

to the Subsystem Management
window online help.

Inappropriate Fibre Channel fabric configurations

This section describes Fibre Channel fabric configuration problems that might be
encountered after you have configured your storage subsystems and have activated
and enabled the Remote Mirror Option.

Information about the probable cause and preferred resolution for each problem is

provided.
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If your problem is not addressed in this section, refer to the remaining sections in

this chapter before contacting technical support.

Problem

Cause

Resolution

The primary logical drive is unable to
contact the Fibre Channel fabric.

Usually, this error occurs because of
a failed Fibre Channel fabric or
because of cabling problems between
the primary and secondary storage
subsystems participating in a remote
logical drive mirror.

* If the Fibre Channel fabric has
failed: Repair or replace the failed
fabric.

If the Fibre Channel fabric is
operational: Check the
configurations cabling. The cable
must not go through a hub or be
connected directly between storage
subsystems. Ensure that the cable
is attached through a switch.

For step-by-step instructions on
configuring storage subsystems for
remote logical drive mirroring, refer to

Chapter 2, “Hardware and software)

installation” on page 21|

The primary logical drive is unable to
communicate with the secondary
storage subsystem. The primary
storage subsystem can still
communicate with the fabric.

Usually, this error occurs when the
secondary storage subsystem has
lost power or when network problems
exist between the secondary storage
subsystem and the fabric.

* The secondary storage subsystem
has no power: If the secondary
storage subsystem has no power
and is not operational, restore
power to the storage subsystem.
For information on powering on
storage subsystems, refer to your
hardware documentation.

* The secondary storage subsystem
has power and is operational:
Check the network status. Ensure
that the secondary storage
subsystem is visible on the
network. Ensure that cables are
correctly connected.

For step-by-step instructions on
configuring storage subsystems for
remote logical drive mirroring, refer to

Chapter 2, “Hardware and softwarel

installation” on page 21|

Storage subsystem component failures

This section describes the impact of physical or logical storage subsystem
component failures on remote logical drive mirroring functionality. Information about
the probable cause and preferred resolution for each problem is provided. If your
problem is not addressed in this section, refer to the remaining sections in this
chapter before contacting technical support.
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Problem

Cause

Resolution

A FlashCopy logical drive created for
a primary logical drive indicates that it
has failed.

The base logical drive for the
FlashCopy logical drive is a primary
logical drive involved in a mirror
relationship. A role reversal was
performed, demoting the primary
logical drive to secondary logical drive
status, resulting in a FlashCopy
logical drive on the secondary logical
drive.

The base logical drive for a
FlashCopy logical drive cannot be a
candidate for the secondary logical
drive role in a remote logical drive
mirror, and the FlashCopy logical
drive has therefore failed.

Perform a role reversal to promote
the secondary logical drive to the
primary logical drive role. After the
role reversal is complete, the
FlashCopy logical drive will return to
Optimal status.

For step-by-step instruction, refer to

“Changing a secondary logical drive]

to a primary drive” on page 57| or to

he Subsystem Management window
online help.

The primary storage subsystem
controller indicates that it has failed.

Failure of the owning controller on the
primary storage subsystem will
usually cause the associated
multi-path driver on the attached host
computer to transfer ownership of the
alternate controller on the primary
storage subsystem.

When this occurs, the alternate
controller on the primary storage
subsystem begins forwarding newly
written data to its peer on the
secondary storage subsystem. The
secondary controller will take
ownership of the logical drive from its
(secondary) peer controller. This is a
reactive event, which occurs because
of the arrival of a write request from
the primary storage subsystem to the
non-owning controller on the
secondary storage subsystem.

Allow the ownership transfer to
complete. Operations will continue in
a normal fashion, with the alternate
(usually the non-preferred) controller
on the primary storage subsystem
interacting with the alternate controller
on the secondary storage subsystem.

Failure of the non-owning controller
on the primary storage subsystem will
have no direct impact on the status of
the remote logical drive mirrors.

The secondary storage subsystem
controller indicates that it has failed.

One of the following scenarios has
occurred:

+ Controller A on the secondary
storage subsystem has failed,
while Controller A is the owner of
the primary logical drive.

* Controller B on the secondary
storage subsystem has failed while
Controller B is the owner of the
primary logical drive.

In both scenarios, the mirrored logical
drive pair transitions to the
Unsynchronized status.

Restore the failed controller. For
detailed recovery procedures, refer to
the Recovery Guru. Upon restoration
of the failed controller, the primary
storage subsystem will automatically
transition to a Synchronizing status.
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General switch troubleshooting

This section describes some common switch-related problems that might be
encountered when using the Remote Mirror Option. The troubleshooting information
provided relates to switches supported for use with IBM FAStT Storage Manager
Version 8.2. For a list of supported switches, refer to [‘Hardware and software
lrequirements” on page 15|

Information about the probable cause and preferred resolution for each problem is
provided. If your problem is not addressed in this section, refer to the remaining
sections in this chapter before contacting technical support.

Problem Cause Resolution
The host is unable to detect primary | When two or more switches are Change the Domain ID of one or
and secondary storage subsystems cascaded together and have the more of your switches, ensuring that
participating in remote logical drive same Domain ID, host computers are |each one is unique. A Domain ID
mirroring. unable to locate the target device. must be a unique number between 1
Each switch must have a unique and 239, which is used to identify the
Domain ID when attempting to switch to a Fibre Channel fabric. For
cascade two switches together. more information on setting Domain
IDs, refer to your switch user
documentation.

Remote Mirror critical events

Critical Major Event Log (MEL) events are generated when an error occurs that can
affect data availability or results in a degraded mode of operation. The storage
management software responds by alerting the appropriate administrators with
e-mail, SNMP trap, or other configured devices. Since administrative action is
required to correct the problem, the storage subsystem will generally enter a Needs
Attention status. This causes the appropriate indications to be presented through
the storage-management software and an associated Recovery Guru procedure to
be displayed when requested by the end user.

The following provides a description of critical MEL events, with a brief explanation
of what caused the event to be triggered and the preferred resolution. If your
problem is not addressed in this section, refer to the remaining sections in this
chapter before contacting technical support.

Problem

Cause Resolution

Mirrored pair becomes
unsynchronized.

This event is logged when a remote | Refer to the associated Recovery
logical drive mirror transitions to an Guru message for specific recovery
Unsynchronized status, from either a | procedures.

Synchronizing or Optimal status.

Dual-role conflict detected. This event is logged when a dual Refer to the associated Recovery

role-conflict is detected, and is usually | Guru message for specific recovery
the result of a role reversal. Since procedures.

both sides of the mirrored logical
drive pair are in the same primary or
secondary logical drive role, both the
primary and secondary storage
subsystems will report this MEL
event.
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Problem Cause Resolution

Communication error with the This event is logged when an Refer to the associated Recovery
secondary logical drive on the interruption in the link that cannot be | Guru message for specific recovery
secondary remote storage subsystem. | recovered by the firmware Fibre procedures.

Channel device driver is detected.
Error codes and recovery procedures
will assist the user in finding the exact
cause of the communication problem
between storage subsystems
participating in a mirror relationship.

World wide name (WWN) change This event is logged when a storage | Refer to the associated Recovery

notification failed.

subsystem detects during start-up Guru message for specific recovery
processing that its world wide name | procedures.

(WWN) has changed. The WWN can
only change if both controllers of the
array are exchanged while the array
is powered off.

When the firmware detects this name
change, it attempts to notify any
remote storage subsystem that had
previously been participating in a
mirroring relationship with any logical
drive on the array.

Controller firmware version 5.2 upgrades

The Remote Mirror Option is designed so that it is not necessary for the primary
storage subsystem and the secondary storage to run the same controller firmware
level. All inter-controller operations (including those needed for propagation of
newly-written data from the primary logical drive to the secondary logical drive) are
implemented so as to support mixed firmware levels to the greatest extent possible.
This allows firmware upgrades to be performed on both the primary and secondary
storage subsystems without any loss of data.

This section describes the procedure that you must follow to upgrade controller
firmware (version 5.20 and higher) to ensure that the Remote Mirror Option works
properly. The preferred sequence for performing firmware upgrades on storage
subsystems participating in mirror relationships is detailed below.

Important: By following this sequence, it is possible to avoid transitions of the
mirrored logical drive pair to an Unsynchronized status, avoiding the need for a full
resynchronization afterwards.

1. Stop I/O to programs that operate on all affected primary logical drives that are
temporarily inactive.

2. Download firmware to the secondary storage subsystem.

Resume program access to primary logical drives. You can operate the primary
storage subsystem with a different firmware level than the secondary storage
subsystem for a time, but the inter-controller protocols for data replication do not
support such interactions.

3. Download the firmware to the primary storage subsystem.
4. Download the firmware to the secondary storage subsystem.

Some configuration operations, such as the establishment of new mirrors and
modification of mirror parameters, might not be allowed between storage
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subsystems that have different firmware levels and will result in error messages.
However, the key data availability operations, including promotion from the
secondary logical drive to the primary logical drive, are allowed in such
circumstances.
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Appendix A. Getting information, help, and service

If you need help, service, or technical assistance or just want more information
about IBM products, you will find a wide variety of sources available from IBM to
assist you. This section contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your computer, and whom to call for service should it be necessary.

Getting information

Information about your IBM server product and preinstalled software, if any, is
available in the documentation that comes with your server. That documentation
includes printed books, online books, README files, and help files. In addition,
information about IBM products is available on the World Wide Web.

On the World Wide Web, the IBM Web site has up-to-date information about IBM
products and support. The address for the IBM Personal Computing home page is
http://www.ibm.com/pc/.

You can find support information for your IBM products at
http://www.ibm.com/pc/support/.

If you click Profile from the support page, you can create a customized support
page that is specific to your hardware, complete with Frequently Asked Questions,
Parts Information, Technical Hints and Tips, and Downloadable Files. In addition,
you can choose to receive e-mail notifications whenever new information becomes
available about your registered products.

You also can order publications through the IBM Publications Ordering System at
http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi.

Getting help and service

If you have a problem with your server product, you will find a wide variety of
sources available to help you.

Using the documentation and diagnostic programs

Many problems can be solved without outside assistance. If you experience a
problem with your server product, the first place to start is the troubleshooting
information in your IBM documentation. If you suspect a software problem, see the
documentation, including README files and online help, that comes with the
operating system or application program.

Most IBM server products come with a set of diagnostic programs that you can use
to help you identify hardware problems. See the troubleshooting information in your
IBM documentation for instructions on using the diagnostic programs.

The troubleshooting information or the diagnostic programs might tell you that you
need additional or updated device drivers or other software. IBM maintains pages
on the World Wide Web where you can get the latest technical information and
download device drivers and updates. To access these pages, go to
http://www.ibm.com/pc/support/ and follow the instructions.
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Calling for service

If you have tried to correct the problem yourself and still need help, during the
warranty period, you can get help and information by telephone through the IBM
HelpCenter®. The following services are available during the warranty period:

Problem determination - Trained personnel are available to assist you with
determining if you have a hardware problem and deciding what action is
necessary to fix the problem.

IBM hardware repair - If the problem is determined to be caused by IBM
hardware under warranty, trained service personnel are available to provide the
applicable level of service.

Engineering Change management - Occasionally, there might be changes that
are required after a product has been sold. IBM or your reseller, if authorized by
IBM, will make selected Engineering Changes (ECs) available that apply to your
hardware.

The following items are not covered:

Replacement or use of non-IBM parts or nonwarranted IBM parts. All warranted
parts contain a 7-character identification in the format IBM FRU XXXXXXX.
Identification of software problem sources.

Configuration of BIOS as part of an installation or upgrade.

Changes, modifications, or upgrades to device drivers.

Installation and maintenance of network operating systems (NOS).

Installation and maintenance of application programs.

Refer to your IBM Statement of Limited Warranty for a full explanation of IBM
warranty terms. Be sure to retain your proof of purchase to obtain warranty service.

In the U.S. and Canada, these services are available 24 hours a day, 7 days a
week. In the U.K., these services are available Monday through Friday, from 9:00
a.m. to 6:00 p.m.

Note: Response times vary; may exclude some holidays.

Please have the following information ready when you call:

Machine type and model

Serial numbers of your IBM hardware products
Description of the problem

Exact wording of any error messages

Hardware and software configuration information

Telephone numbers

Telephone numbers are subject to change without notice. For the most up-to-date
phone numbers, go to http://www.ibm.com/pc/support/ and click Support Phone
List.

74

IBM FAStT Remote Mirror Option: Installation and User’s Guide



Country Telephone number
Austria Osterreich 01-24 592 5901
Belgium - Dutch Belgie 02-210 9820
Belgium - French Belgique 02-210 9800
Canada Toronto only 416-383-3344
Canada Canada - all other 1-800-565-3344
Denmark Danmark 45 20 82 00
Finland Suomi 09-459 6960
France France 02 38 55 74 50
Germany Deutschland 07032-1549 201
Ireland Ireland 01-815 9202
Italy Italia 02-7031 6101
Luxembourg Luxembourg 298-977 5063
Netherlands Nederland 020-514 5770
Norway Norge 66 81 11 00
Portugal Portugal 21-791 51 47
Spain Espafia 91-662 49 16
Sweden Sverige 08-477 4420
Switzerland Schweiz/Suisse/Svizzera 058-333 0900
United Kingdom United Kingdom 01475-555 055
U.S.A. and Puerto Rico U.S.A. and Puerto Rico 1-800-772-2227

In all other countries or regions, contact your IBM reseller or IBM marketing

representative.

International Warranty Service

If you travel with your server product or relocate it to a country where your server
machine type is sold, your server product might be eligible for International

Warranty Service, which automatically entitles you to obtain warranty service
throughout the warranty period. Service will be performed by IBM or by IBM

resellers who are authorized to perform warranty service.

Service methods and procedures vary by country, and some services might not be
available in all countries. International Warranty Service is delivered through the
method of service (such as depot, carry-in, or on-site service) that is provided in the
servicing country. Service centers in certain countries might not be able to service
all models of a particular machine type. In some countries, fees and restrictions
might apply at the time of service.

To determine whether your server product is eligible for International Warranty
Service and to view a list of the countries where service is available, go to
http://www.ibm.com/pc/support/, and click Warranty Lookup. Eligible IBM server
products are identified by their four-digit machine types. For more information about
International Warranty Service, see Service Announcement 601-034 at
http://www.ibm.com/. Click Support & downloads, click Announcement letters,
and click Announcements search. In the Search by letter number only field,
type 601-034, and click Search.
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Purchasing additional services

During and after the warranty period, you can purchase additional services, such as
support for IBM and non-IBM hardware, operating systems, and application
programs; network setup and configuration; upgraded or extended hardware repair
services; and custom installations. Service availability and service name might vary
by country or region.

For more information about these services, contact your IBM marketing
representative.
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Appendix B. Notices

This publication was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this publication to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Edition notice

© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2002.
All rights reserved.

Note to U.S. Government Users — Documentation related to restricted rights —
Use, duplication or disclosure is subject to restrictions set forth in GSA ADP
Schedule Contract with IBM Corp.
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Trademarks

The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

e-business logo Predictive Failure

Analysis
FlashCopy ServeRAID
HelpCenter ServerProven
IBM TotalStorage

Lotus, Lotus Notes, and Domino are trademarks of Lotus Development Corporation
and/or IBM Corporation in the United States, other countries, or both.

Intel, Celeron, MMX, LANDesk, Pentium, Pentium Il Xeon, Pentium Il Xeon, and
Xeon are trademarks of Intel Corporation in the United States, other countries, or
both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds.

Other company, product, or service names may be the trademarks or service marks
of others.

Important notes

Processor speeds indicate the internal clock speed of the microprocessor; other
factors also affect application performance.

CD-ROM drive speeds list the variable read rate. Actual speeds vary and are often
less than the maximum possible.

When referring to processor storage, real and virtual storage, or channel volume,
KB stands for approximately 1000 bytes, MB stands for approximately 1 000 000
bytes, and GB stands for approximately 1 000 000 000 bytes.

When referring to hard disk drive capacity or communications volume, MB stands
for 1 000 000 bytes, and GB stands for 1 000 000 000 bytes. Total user-accessible
capacity may vary depending on operating environments.

Maximum internal hard disk drive capacities assume the replacement of any
standard hard disk drives and population of all hard disk drive bays with the largest
currently supported drives available from IBM.

Maximum memory may require replacement of the standard memory with an
optional memory module.
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IBM makes no representation or warranties regarding non-IBM products and
services that are ServerProven®, including but not limited to the implied warranties
of merchantability and fitness for a particular purpose. These products are offered
and warranted solely by third parties.

IBM makes no representations or warranties with respect to non-IBM products.
Support (if any) for the non-IBM products is provided by the third party, not IBM.

Some software may differ from its retail version (if available), and may not include
user manuals or all program functionality.
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